


FileMaker Training Series: Basics for FileMaker 15

Preface	 1
..........................................................................................

Master the Essentials of FileMaker 15	 2 ........................................................

Introduction	 4
...................................................................................

In this Series	 5 .............................................................................................

Lesson 1: FileMaker Platform Overview	 9
........................................

Lesson Overview	 10 .....................................................................................

Section 1: What are FileMaker Apps?	 11 ...............................................................

Section 2: Product Line	 13 ....................................................................................

Product Descriptions in Detail	 15 .................................................................

Section 3: FileMaker Version Compatibility	 17 .......................................................

Section 4: Accessing an App	 18 ...........................................................................

Section 5: Real-World Use Cases	 20 ....................................................................

Section 6: Get Started Options	 22 ........................................................................

Lesson 1: Review Questions	 24 ............................................................................

Lesson 1: Review Answers	 25 ..............................................................................

Lesson 2: Using Starter Solutions	 26
...............................................

Lesson Overview	 27 .....................................................................................

Section 1: Choose a Starter Solution	 28 ................................................................

Section 2: Quick Mobile Development	 32 ..............................................................

Lesson 2: Review Questions	 34 ............................................................................

Lesson 2: Review Answers	 35 ..............................................................................

Lesson 3: Viewing and Working with Data	 36
..................................

�i



FileMaker Training Series: Basics for FileMaker 15

Lesson Overview	 37 .....................................................................................

Section 1: Layouts	 39 ...........................................................................................

Section 2: Modes Within Layouts	 41 .....................................................................

Section 3: Views Within Layouts	 43 ......................................................................

Section 4: Records	 45 ..........................................................................................

Section 5: Working With Data	 47 ..........................................................................

Creating a New Record	 47 ...........................................................................

Duplicating a Record	 48 ...............................................................................

Modifying Data	 49 ........................................................................................

Saving Data	 49 ............................................................................................

Deleting Data	 50 ..........................................................................................

Lesson 3: Review Questions	 53 ............................................................................

Lesson 3: Review Answers	 54 ..............................................................................

Lesson 4: Finding and Sorting Records	 55
......................................

Lesson Overview	 56 .....................................................................................

Section 1: Specifying Search Criteria	 57 ................................................................

Performing AND or OR Searches	 57 ............................................................

Section 2: Extending and Constraining a Found Set	 59 .........................................

Section 3: Using Operators in Search Criteria	 61 ...................................................

Finding Strings of Characters in a Field	 62 ....................................................

Finding a Range of Data	 62 ..........................................................................

Finding Exact Data	 63 ..................................................................................

Section 4: Sorting Records	 64 ..............................................................................

�ii



FileMaker Training Series: Basics for FileMaker 15

Choosing Sort Fields	 64 ...............................................................................

Setting Sort Order	 65 ...................................................................................

Lesson 4: Review Questions	 66 ............................................................................

Lesson 4: Review Answers	 67 ..............................................................................

Lesson 5: User-Centered Design	 68
................................................

Lesson Overview	 69 .....................................................................................

Section 1: What is User-Centered Design?	 70 .......................................................

Three Basic Principles	 70 .............................................................................

Think Goals Not Features	 70 ........................................................................

Think Differently	 70 .......................................................................................

Section 2: Basic Principles	 71 ...............................................................................

Section 3: Equipment Providers, Inc.	 72 ................................................................

Lesson 5: Review Questions	 74 ............................................................................

Lesson 5: Review Answers	 75 ..............................................................................

Lesson 6: Importing Data	 76
............................................................

Lesson Overview	 77 .....................................................................................

Section 1: Converting an Existing File	 78 ...............................................................

Section 2: Converting Excel Files	 79 .....................................................................

Lesson 6: Review Questions	 81 ............................................................................

Lesson 6: Review Answers	 82 ..............................................................................

Lesson 7: Creating Fields and Tables	 83
..........................................

Lesson Overview	 84 .....................................................................................

�iii



FileMaker Training Series: Basics for FileMaker 15

Section 1: Create New Tables	 85 ..........................................................................

Section 2: Field Types	 87 ......................................................................................

Fields Used to Automate and Aggregate Data	 88 .........................................

Section 3: Create New Fields from the Field Picker	 89 ..........................................

Lesson 7: Review Questions	 91 ............................................................................

Lesson 7: Review Answers	 92 ..............................................................................

Lesson 8: Relationships	 93
..............................................................

Lesson Overview	 94 .....................................................................................

Relationship Types	 94 ..................................................................................

Identifying Relationship Types	 96 ..................................................................

Section 1: Using Primary and Foreign Keys to Relate Tables	 97 ............................

Primary Keys	 97 ...........................................................................................

Foreign Keys	 98 ...........................................................................................

Section 2: Creating Relationships	 99 .....................................................................

Creating Relationships	 99 .............................................................................

Lesson 8: Review Questions	 101 ..........................................................................

Lesson 8: Review Answers	 102 ............................................................................

Lesson 9: Layouts	 103
.....................................................................

Lesson Overview	 104 ...................................................................................

Section 1: Creating Layouts	 105 ...........................................................................

Layout Parts	 106 ..........................................................................................

Section 2: Adding Fields to a Layout	 107 ..............................................................

Selecting Fields from Field Picker	 108 ..........................................................

�iv



FileMaker Training Series: Basics for FileMaker 15

Section 3: Layout Themes and Styles	 109 ............................................................

Themes	 109 .................................................................................................

Styles	 110 ....................................................................................................

Section 4: Creating More Layouts	 112 ..................................................................

Lesson 9: Review Questions	 115 ..........................................................................

Lesson 9: Review Answers	 116 ............................................................................

Lesson 10: Layout Design Tools	 117
................................................

Lesson Overview	 118 ...................................................................................

Section 1: Status Toolbar and Inspector	 120 .........................................................

Inspector	 120 ...............................................................................................

Section 2: Layout Resizing	 122 .............................................................................

Layout Width	 122 .........................................................................................

Screen Stencils	 122 .....................................................................................

Selecting, Resizing, and Moving Objects	 123 ...............................................

Section 3: Guides and Grids	 125 ..........................................................................

Dynamic Guides	 125 ....................................................................................

Ruler Guides	 125 .........................................................................................

Object Grid	 126 ...........................................................................................

Section 4: Using Layout Design Tools	 127 ............................................................

Lesson 10: Review Questions	 130 ........................................................................

Lesson 10: Review Answers	 131 ..........................................................................

Lesson 11: Special Layout Objects	 132
...........................................

Lesson Overview	 133 ...................................................................................

�v



FileMaker Training Series: Basics for FileMaker 15

Section 1: Portal	 135 ............................................................................................

Section 2: Tab Control	 139 ....................................................................................

Section 3: Slide Control	 141 ..................................................................................

Section 4: Popover	 143 ........................................................................................

Section 5: Web Viewer	 145 ...................................................................................

Lesson 11: Review Questions	 148 ........................................................................

Lesson 11: Review Answers	 149 ..........................................................................

Lesson 12: Formatting Field Objects	 150
........................................

Lesson Overview	 151 ...................................................................................

Section 1: Data Formatting	 152 ............................................................................

Section 2: Conditional Formatting	 154 ..................................................................

Section 3: Field Control Styles	 156 ........................................................................

Section 4: Value Lists	 157 .....................................................................................

Lesson 12: Review Questions	 159 ........................................................................

Lesson 12: Review Answers	 160 ..........................................................................

Lesson 13: User Interface Best Practices	 161
.................................

Lesson Overview	 162 ...................................................................................

Section 1: User Interface Best Practices	 163 ........................................................

Read the Human Interface Guidelines	 164 ...................................................

Read the FileMaker WebDirect Guide	 164 ....................................................

Lesson 13: Review Questions	 165 ........................................................................

Lesson 13: Review Answers	 166 ..........................................................................

�vi



FileMaker Training Series: Basics for FileMaker 15

Lesson 14: Calculations	 167
............................................................

Lesson Overview	 168 ...................................................................................

Section 1: Creating Calculations	 169 .....................................................................

Specify Calculation Dialog	 169 .....................................................................

Creating Calculation Fields	 170 ....................................................................

Section 2: Functions and Operators	 172 ...............................................................

Functions	 172 ..............................................................................................

Operators	 173 ..............................................................................................

Boolean Results	 174 ....................................................................................

Lesson 14: Review Questions	 176 ........................................................................

Lesson 14: Review Answers	 177 ..........................................................................

Lesson 15: Scripting	 178
..................................................................

Lesson Overview	 179 ...................................................................................

Section 1: What Are Scripts?	 180 .........................................................................

Script Steps	 180 ..........................................................................................

Section 2: Creating and Organizing Scripts	 181 ....................................................

Organizing Scripts	 181 .................................................................................

Section 3: Editing Scripts	 183 ...............................................................................

Section 4: Triggering Scripts	 184 ..........................................................................

Section 5: Buttons & Button Bars	 185 ...................................................................

Single Step Scripts	 189 ................................................................................

Create email with file as attachment	 194 ......................................................

Section 6: Startup Script	 195 ................................................................................

�vii



FileMaker Training Series: Basics for FileMaker 15

Lesson 15: Review Questions	 197 ........................................................................

Lesson 15: Review Answers	 198 ..........................................................................

Lesson 16: Reporting	 199
................................................................

Lesson Overview	 200 ...................................................................................

Section 1: Subsummary Reports	 202 ....................................................................

Subsummary Parts	 203 ...............................................................................

Summary Fields	 204 ....................................................................................

Using Subsummary Parts to Enhance User Experience	 206 .........................

Section 2: Charts	 209 ...........................................................................................

Quick Charts	 209 .........................................................................................

Lesson 16: Review Questions	 211 ........................................................................

Lesson 16: Review Answers	 212 ..........................................................................

Lesson 17: Integration	 213
...............................................................

Lesson Overview	 214 ...................................................................................

Section 1: Sharing Data With Outside Users	 216 ..................................................

Exporting Records	 216 ................................................................................

Saving as a PDF	 217 ....................................................................................

Section 2: Integrating with Other Data Sources	 219 ..............................................

Section 3: What Is ODBC?	 220 .............................................................................

External SQL Sources (ESS)	 220 ..................................................................

Import from ODBC Data Sources	 220 ..........................................................

Execute SQL Script Step	 221 ......................................................................

Lesson 17: Review Questions	 222 ........................................................................

�viii



FileMaker Training Series: Basics for FileMaker 15

Lesson 17: Review Answers	 223 ..........................................................................

Lesson 18: Security	 224
...................................................................

Lesson Overview	 225 ...................................................................................

Section 1: Prompt for Login	 227 ...........................................................................

Section 2: Accounts	 229 .......................................................................................

Section 3: Privilege Sets	 230 .................................................................................

Lesson 18: Review Questions	 234 ........................................................................

Lesson 18: Review Answers	 235 ..........................................................................

Lesson 19: Deployment	 236
.............................................................

Lesson Overview	 237 ...................................................................................

Section 1: Network Sharing	 238 ...........................................................................

Using FileMaker Pro	 238 ..............................................................................

Using FileMaker Server	 239 ..........................................................................

Section 2: Opening FileMaker Files	 240 .................................................................

Opening Local Files	 240 ...............................................................................

Transferring Files to an iOS Device	 240 ........................................................

Opening Hosted Files	 242 ............................................................................

Lesson 19: Review Questions	 244 ........................................................................

Lesson 19: Review Answers	 245 ..........................................................................

Conclusion	 246
.................................................................................

Conclusion	 247 .....................................................................................................

Copyright	 248
...................................................................................

�ix



FileMaker Training Series: Basics for FileMaker 15

Copyright	 249.......................................................................................................

�x



FileMaker Training Series: Basics for FileMaker 15

Preface

�1



FileMaker Training Series: Basics for FileMaker 15

PREFACE


Preface

Master the Essentials of FileMaker 15 
Congratulations on selecting the FileMaker Training Series! The FileMaker Training Series: Basics 
and the FileMaker Training Series: Advanced make up the official curriculum for learning how to use 
FileMaker software to build professional apps. 

The FileMaker Training Series: Basics focuses on the features and benefits of the FileMaker 
Platform with special attention to the newest version, FileMaker 15. You will learn how to build 
a sample FileMaker app from start to finish.


The FileMaker Training Series: Advanced is for intermediate to advanced FileMaker developers, 
but anyone who creates FileMaker databases can benefit from it. It also serves as a stepping-stone 
to becoming a FileMaker 15 Certified Developer. FileMaker Training Series: Advanced is a separate 
purchase.  

Necessary materials

The FileMaker Training Series: Basics training has activities to guide you through the FileMaker 
Platform. In order to follow along, make sure you have the following materials. 

Software

Before you begin the training, you will need the following software: 

FileMaker Pro 15 – download 30-day trial: 
http://www.filemaker.com/trial 

FileMaker Go 15 – free download from the App Store:  
http://www.filemaker.com/fmgo 

Activity Files

The activities in this training will use the following files: 

• Contacts.fmp12 

• Customers.xlsx 

• Assets.xlsx 

App File

This is an example of the finished app being built in this training: 

• Equipment Rentals.fmp12 
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To download the activity and app files, visit: http://www.filemaker.com/r/fts_basics_15_activities 

Adobe Acrobat Reader DC

In order to perform a search within the PDF version of this document, you must view it using 
Adobe Acrobat Reader DC. 

If you have the PDF version of this document, be sure to view it with Adobe Acrobat Reader DC. 
This will allow you to search the document’s contents.  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Introduction

In this Series 
What if you could streamline your business by creating custom apps that transform the way you 
and your team work? Instead of relying on spreadsheets, paper forms, or multiple applications to 
get your work done, connect your team together with interactive screens, reports, and dashboards 
that deliver all the information they need in one place. The FileMaker Platform puts you in control, 
providing an easy way to create apps that meet the specific needs of your business. 

People and organizations all over the world rely on the FileMaker Platform to manage, analyze, and 
share important information. The software is available in over 60 countries in 17 languages and is 
used by all types of organizations, including government, education, healthcare, retail, 
manufacturing, real estate, legal, and more. 

The FileMaker Platform is a line of products that work together to streamline your business. You 
can easily create apps to manage and share information with your team on Mac, Windows, mobile 
devices, and the web. 

FileMaker databases are generally referred to as “apps”, because they bring together many 
software elements to solve business problems. Apps built with the award-winning FileMaker 
Platform are used to streamline a wide range of functions like project management, asset 
management, invoicing and billing, and customer relationship management (CRM). 

The training materials available for the FileMaker Platform include: 

• The FileMaker Pro Tour in FileMaker Pro and the Getting Started Tour in FileMaker 
Go, which take you through the key features so you can start to build and use an app 
immediately. 

• The FileMaker Training Series: Basics, which builds on these tours and introduces 
how you can use the FileMaker Platform to create and deploy custom data 
management apps. 

• The FileMaker Training Series: Advanced, which provides in-depth coverage of 
FileMaker development practices and techniques in preparation for the FileMaker 15 
Certification Exam. 

The FileMaker Training Series: Basics focuses on the features and benefits of the FileMaker 
Platform with special attention to the newest version, FileMaker 15. For simplicity, "FileMaker" is 
used throughout the training except in cases where a feature is specific to FileMaker 15. 

You will learn the capabilities of the two key products for creating apps—FileMaker Pro and 
FileMaker Pro Advanced. While FileMaker Pro Advanced includes all the same features as 
FileMaker Pro, it also provides a suite of advanced development and customization tools. For 
simplicity, "FileMaker Pro" is used as a general term when referring to the software used to create 
apps.  
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FileMaker Training Series: Basics assumes that you have FileMaker Pro installed on your Mac or 
Windows computer and FileMaker Go installed on your iOS device. Activities are included in the 
training that require you to use both products. 
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The FileMaker Training Series: Basics is organized as follows: 

• In Lessons 1 - 2, you will be introduced to: 

๏ The FileMaker Platform 

๏ FileMaker Starter Solutions 

• In Lessons 3 - 5, you will learn about using a FileMaker app and how to: 

๏ Navigate a FileMaker app 

๏ View and modify data in an app 

๏ Find and sort data in an app 

• In Lesson 6, you will learn about user-centered design including: 

๏ Planning an app to solve the right problems 

๏ A sample scenario used for the rest of the lessons 

• In Lessons 7 - 8, you will learn about data and how to: 

๏ Import data into a FileMaker app 

๏ Create tables, fields, and relationships for your data 

• In Lessons 9 - 13, you will learn about user interface design and how to: 

๏ Use themes, styles, guides, and other FileMaker design tools 

๏ Create interfaces for iOS devices 

๏ Create efficient interfaces for the user 
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• In Lessons 14 - 19, you will learn about powerful tools in the FileMaker Platform 
including: 

๏ Calculations, Scripting, and Reporting 

๏ Integration with other business systems 

๏ Security 

๏ Sharing and deployment of your app to other users 

We appreciate your interest in learning how FileMaker can solve your business challenges. We 
support you in your training process and encourage you to visit the FileMaker Community at 
https://community.filemaker.com/, where you can post your questions and learn from other 
people’s experience.  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Lesson 1: FileMaker Platform 
Overview

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Objectives: FileMaker Platform

After this lesson, you will be able to: 

• Identify the four products of the FileMaker Platform. 

• Identify the requirements for building, accessing, and hosting FileMaker apps. 

• Compare and contrast FileMaker Pro and FileMaker Go. 

• List the additional features in FileMaker Pro Advanced. 

• Describe real-world uses of FileMaker apps. 

The FileMaker 15 Platform is a set of tools and technologies that enable you to create, deploy, and 
manage custom business apps, as well as modify them as your organizational needs change. You 
can create apps that run on iPad, iPhone, Mac, Windows, and the web. 

Apps that are well-designed allow easy collection and sharing of data in various locations, such as 
customer information at a sales event and safety checklists at a worksite. Imagine, for example, a 
safety inspector collecting data in the field with FileMaker Go for iPad—taking pictures, entering 
notes—and uploading this data to FileMaker Server so that FileMaker Pro users in the office can 
see and use the data right away. The products that make up the FileMaker Platform work together 
to let users see and interact with the same information in real time. 

In this lesson, you will learn about the different products in the FileMaker Platform, what they do, 
and how they work together. 
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LESSON 1


Section 1: What are FileMaker 
Apps?

A FileMaker app is made up of one or more files that resolve business issues and improve data 
management. Well-designed apps that are customized to meet the specific needs of a business 
help employees do their jobs more quickly and easily, reduce operating costs, and enhance 
customer satisfaction. 

A custom FileMaker app may contain the following components: 

Data

Almost every application today—an online catalog, an address book, a calendar—is driven by a 
database engine. All of these applications store and retrieve a variety of data in a structured format.  

A database contains two parts: a data structure and the data that lives within that structure. 
FileMaker has a database at its core for creating structure like tables, fields, and relationships. This 
provides the foundation for users to interact with the data stored in the structure. 

Interface

In an app, the interface provides users with a way to view and interact with the data. A well-
designed app will incorporate business rules for what data the user can view, find, and modify, and 
how they do so. The interface revolves mostly around layouts and layout objects. 

App Logic

App logic adds automation to make users more productive. The two main tools FileMaker Pro 
provides for automating app logic are calculations and scripting. Calculations provide access to 
complex, calculated data. Scripts allow users to complete tasks quickly and efficiently by 
automating certain portions of the business process or by guiding them through the process. Both 
scripts and calculations increase data integrity by standardizing business processes. 

Reporting

FileMaker Pro provides step-by-step reporting tools, including eye-catching charts, to help analyze 
and summarize data in meaningful ways. You can easily create and email reports in Excel or PDF 
format to share with others. FileMaker Pro makes this possible by combining data, interface, and 
app logic. 

Integration

Integrating a FileMaker app with other technologies can improve the efficiency of your workgroup 
and extend the capabilities of an app. The FileMaker Platform allows you to import and export to 
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file formats like Excel and comma-separated text, work with data in ODBC compatible systems like 
SQL Server and MySQL, display web pages on your layouts, and much more. 

Security

Security is a critical component of any modern system. FileMaker Pro has built-in tools that allows 
you to manage the security of your FileMaker app. You can restrict access to entire FileMaker files 
as well as to individual tables, records, fields, layouts, scripts, and so on. 

Deployment

Providing access to an app by one or more users is possible through FileMaker deployment 
capabilities. FileMaker apps are often hosted on FileMaker Server, giving consistent access to 
multiple simultaneous users, as well as providing other benefits like automated backups and 
secure data connections. 

The FileMaker Advantage

The FileMaker Platform combines data structure, interface, scripting, and calculations to create a 
cohesive developer and user experience. Since these tools are available in a single platform, 
employing a separate database administrator, UI designer, and programmer is not always 
necessary to create a business app. With the help of the tools and templates provided within 
FileMaker products, a single knowledge worker with a solid understanding of the FileMaker 
Platform can create a custom app for their department or organization. 

FileMaker apps can often be created in days or weeks rather than months or years. Modifications 
and feature additions can be done in minutes or hours.  

You can start small and grow your app over time. Keep in mind that building more complex apps 
requires planning, preparation, and knowledge of the product features. The FileMaker Training 
Series provides instruction on these steps. 
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LESSON 1


Section 2: Product Line

How Products Work Together

You start with FileMaker Pro on a Windows or Mac computer to create your custom business app. 
You may choose to use FileMaker Pro Advanced if you need additional development and 
customization tools. 

Then, to run your app on iPad or iPhone, use the free FileMaker Go app which is available on the 
App Store. 

For a small team with occasional access, FileMaker Pro can share apps with up to 5 other 
FileMaker Pro or FileMaker Go users (shown in Figure 1). 

� 

FIGURE 1


In most cases, however, FileMaker Server offers a better deployment option. It permits sharing with 
many more users, runs on an independent machine, and promotes peace of mind through 
automatic backup schedules. Security options include installing a third party SSL certificate to 
provide secure connections between FileMaker Server and FileMaker Pro, FileMaker Go, and 
FileMaker WebDirect clients. FileMaker Server also includes other robust features, such as the 
ability to access your app from a web browser, using FileMaker WebDirect or Custom Web 
Publishing technologies (Figure 2). 

�13



FileMaker Training Series: Basics for FileMaker 15

� 

FIGURE 2


Knowing how users will connect to your app helps determine what to purchase. Users with a paid 
license of FileMaker Pro on Windows or Mac can connect to FileMaker Server for no additional 
cost. 

FileMaker Server has been tested for 250 simultaneous connections using FileMaker Pro and 
FileMaker Pro Advanced. Theoretically, the number of connections has no restrictions and is limited 
only by hardware, database design, and operating system. 

Users with web browsers, or users running FileMaker Go on iPad and iPhone, require paid 
connections to FileMaker Server. These paid connections are called "concurrent connections.” 

For example, a team with several members connects to FileMaker Server using iPad, iPhone, or a 
web browser throughout the day. At various times, there are different numbers of users connected 
(as shown in Figure 3). The number of concurrent connections needed is determined by the 
maximum number of people connected at any one time using iPad, iPhone, or a web browser. 

� 

FIGURE 3


FileMaker Server comes with one concurrent connection so you can test your app using iPad, 
iPhone, or a web browser. You can purchase additional concurrent connections in groups of 5. 
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For example, if the maximum number of people connected at any one time using iPad, iPhone, or 
a web browser is 8, you will need to purchase two groups of 5 concurrent connections to equal 10 
connections. As your team grows, you can add more concurrent connections in groups of 5. Up to 
100 concurrent connections can be used with FileMaker WebDirect and FileMaker Go. 

In summary: 

• Use FileMaker Pro or FileMaker Pro Advanced to create and run apps on Windows or 
Mac, purchasing a FileMaker Pro license for each Windows and Mac user. 

• Use FileMaker Go to run apps on iPad or iPhone, downloading the free FileMaker Go 
app for each iPad and iPhone user. 

• When using FileMaker Server to share your app with larger teams and to enable web 
browser connections, purchase licenses of FileMaker Pro for all your Windows and Mac 
users as well as the appropriate number of concurrent connections for your iPad, 
iPhone, and web browser users. 

Product Descriptions in Detail 
While the products in the FileMaker Platform are designed to work together, they each have their 
own roles and capabilities. For the latest technical specs and hardware requirements, visit the 
FileMaker website. 

FileMaker Pro 15

FileMaker Pro is desktop software for Windows and Mac that allows you to design and build 
custom apps, while also using ready-made apps built by others. 

FileMaker Pro provides tools to define data structure, create layouts to view data, and share data 
with up to five other network connected users, which is called “peer-to-peer" sharing. (The "peer-
to-peer" data sharing works well for lightweight uses, but FileMaker Server is the best tool for 
sharing FileMaker apps.) 

FileMaker Pro 15 Advanced

Like FileMaker Pro, FileMaker Pro Advanced is also desktop software for Windows and Mac, 
offering all the same features plus additional programming and development tools, including script 
debugging and the ability to create custom menus and database design reports. 

The Script Debugger and Data Viewer are essential tools for troubleshooting app logic. The Script 
Debugger allows developers to walk through scripts step by step for testing purposes. The Data 
Viewer can be used to monitor fields and variables while scripts are running and write and test 
calculations before using them for real business purposes. 

Developers can customize the behavior of the application itself using Custom Menus and Custom 
Functions. Custom Menus let FileMaker developers take control of the organization and behavior of 
the menubar, and Custom Functions let FileMaker developers create their own functions to use in 
the FileMaker calculation dialog. 
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FileMaker Pro Advanced also contains tools for creating a Database Design Report (DDR), which 
documents the internal structure of a FileMaker app. FileMaker Pro Advanced is also necessary in 
order to enable features like file encryption and kiosk mode for your app. 

The additional tools in FileMaker Pro Advanced are an essential part of a developer’s toolkit, 
making it a must-have product for those who will be creating or maintaining apps.  

FileMaker Go 15

The FileMaker Go app allows users to access FileMaker apps on iOS devices, including iPad, iPad 
mini, iPad Air, iPhone, and iPod touch. The app provides access to hosted (online) or locally stored 
(offline) FileMaker apps. 

For FileMaker apps that are hosted, the iOS device must be connected to a network via Wi-Fi or a 
cellular connection to access the app. Similar to FileMaker Pro, data entered while working on a 
mobile device will be immediately available to all other connected users. 

FileMaker Go can also access a FileMaker app stored locally on the device for offline use. By using 
FileMaker scripting or a commercial app, the offline data can later be synchronized with a hosted 
app for sharing among many users. 

FileMaker Server 15

FileMaker Server software acts as a server for hosting FileMaker apps. Hosted apps can be used 
by hundreds of people at the same time with the data shared securely between the server and 
users. FileMaker Server can also allow access to FileMaker apps via FileMaker WebDirect, which 
provides access through a user's web browser. 

FileMaker Server can: 

• Run scheduled, automated backups of database files  

• Log usage and performance statistics  

• Execute server-side scripts, including FileMaker scripts and system-level scripts 
(including Windows batch, Perl, VBScript, and AppleScript)  

• Provide secure data transfer over networks  

• Deploy an app to anyone with a compatible web browser, without using web authoring 
tools or other technologies, via FileMaker WebDirect 

FileMaker Server also includes the FileMaker API for PHP and XML Custom Web Publishing (CWP). 
Developers who are skilled in those technologies can use this API to build dynamic websites that 
interact with FileMaker apps. 
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LESSON 1


Section 3: FileMaker Version 
Compatibility

The FileMaker 15 Platform uses a specific file format that has been available since FileMaker 12. 
Files created in this format have the extension of .fmp12. For users of FileMaker versions prior to 
12, it will be necessary to convert older file formats to the new .fmp12 format before using 
FileMaker 15. 

More information on converting to FileMaker 15 can be found here: 

http://www.filemaker.com/products/filemaker-pro/conversion.html 
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LESSON 1


Section 4: Accessing an App

When building a FileMaker app, it helps to keep in mind how it will be accessed. A single FileMaker 
app can provide different functionality based on the platform from which it is accessed. For 
example, people may access the same app using: 

• FileMaker Pro as a robust way for office employees to create, edit, and review orders 

• FileMaker Go as a mobile way for warehouse employees to change the status of an 
order, get a signature from the recipient, and email the client a receipt of the order 

• FileMaker WebDirect as an ad-hoc way for clients to check the status of their order 
using a web browser 

FileMaker Pro has the flexibility and power for you to build layouts for all platforms in one app. 
Following are the benefits of each product and platform: 

FileMaker Pro

As a native application on Windows and Mac, FileMaker Pro offers ideal features for office work, 
such as the processing power of a desktop machine, the efficiency of keyboard shortcuts, and the 
ability to view multiple windows at once. Layouts designed for a full-sized monitor can offer an 
immersive experience and a more encompassing view of the data. 

FileMaker Go

FileMaker Go benefits from being on an iOS device, making your data more portable. It also takes 
advantage of some device specific features: 

• Take a photo or record a video with the built-in camera and store it in a FileMaker app 

• Enter or find data by using the camera as a bar code scanner 

• Dial phone numbers stored in a FileMaker app 

• Add location data (latitude and longitude) to records 

• Capture signatures 

FileMaker WebDirect

FileMaker WebDirect provides a rich user experience similar to using FileMaker Pro. It is ideal for 
enabling teams located in remote offices to share information easily. Use FileMaker WebDirect to 
securely collect information like status updates, surveys, feedback forms, and more from 
geographically dispersed colleagues and associates. 
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However, because FileMaker WebDirect has some differences in functionality compared to 
FileMaker Pro, it is better suited as a complementary client rather than a replacement client in many 
situations. 

For a feature-by-feature comparison, please read the FileMaker WebDirect Guide: 

https://fmhelp.filemaker.com/docs/15/en/fm15_webdirect_guide.pdf 
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Section 5: Real-World Use 
Cases

FileMaker apps are used to streamline a vast range of functions including: project management, 
asset management, invoicing and billing, catalog creation, customer relationship management 
(CRM), patient records management, film and video production, sales and advertising 
management, and customer service.  

The FileMaker website showcases real-world examples of how people use FileMaker apps around 
the world: http://www.filemaker.com/solutions/customers/ 

A few examples are highlighted below: 

Increasing Sustainability with FileMaker Go

The FileMaker Platform allows Sea Breeze Farm — a grass-based animal farm known for their 
world-class winery, restaurant, charcuterie, butcher, and cheese shops — to go paperless. George 
Page, Sea Breeze Farm's owner, sees the use of the FileMaker Platform as one that will elevate his 
farm's overall efficiency, as well as profits. 

For the dairy operation, FileMaker Go for iPad allows Page and his staff to understand the 
production levels of cows on the farm. For the cheese business, employees note which types of 
milk are used in making cheese rounds and identify how long each round has been aged. In the 
wine cellar, FileMaker Go for iPad has replaced clipboards for entering alcohol levels, pH readings, 
sulfite additions, and historic data related to wine lots, while replacing paper notes. 

FileMaker Go for iPad is reducing paper use and improving productivity among employees. The 
FileMaker Platform is also making it easier for Page to gain business insights through visual 
features such as charting. Page says, "FileMaker Pro helps me easily create custom business apps 
for iPad. The systems we have now are pleasing to look at, as well as highly functional — and that 
means our employees genuinely want to use them.” 

Streamlining Work Orders with a FileMaker app

Construction and service company Market Refrigeration Specialists installs and maintains large 
refrigeration and HVAC systems for major retailers such as WalMart, Target, Whole Foods, Sprouts, 
Vons, and Albertsons. Using FileMaker Go for iPad, field technicians process work orders, time 
cards, and parts requests in real time, shrinking revenue cycles from two months to two weeks. 

In the past, Market Refrigeration Specialists' field technicians had to fill out paper work orders in 
triplicate. Likewise, parts orders had to be written up and faxed. Now, with the new FileMaker app, 
technicians can clearly view their daily assignments and work orders and travel to various client 
sites. Once they arrive at a destination, they can review client requirements and project parameters 
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and get to work right away. Everything runs on FileMaker Server in the main office, so as orders are 
completed, data is instantly recorded in the central database for invoicing. 

On a day-to-day basis, their FileMaker app provides technicians with a simple, self-populating form 
for reporting refrigerant handling. This information must get to the Environmental Protection Agency 
within seven days or Market Refrigeration Specialists could face fines of up to $10,000. But that’s 
no longer a challenge: simply by answering a few questions and hitting Submit on the iPad, 
technicians automatically transfer information to an EPA certification document. 

Improving Efficiency and Communication with FileMaker Go

Musashino Corporation, based out of Koganei City in Tokyo, Japan, operates over 240 seminar 
events per year. To manage the seminars, Musashino developed a Seminar Progress Management 
app on the FileMaker Platform. 

Previously, Musashino managed all the events with paper and clipboards. With FileMaker Go for 
iPad, staff can now check their assigned tasks and help others with their tasks if delays occur. 
Previously, last minute changes would not get communicated effectively, but with the FileMaker 
app, the data is up to date for all staff. The quality of work has improved and seminar operational 
efficiency has increased, enabling the staff to spend more time with customers. 

Additionally, Musashino uses their FileMaker app to complete in-house inspections of workplace 
environments. Similar to the events managed by Musashino, the inspections were previously 
completed with paper and pen. Now, FileMaker Go for iPad allows staff to review the itemized 
checklist and report their findings much faster than before. Noboru Koyama, President of 
Musashino, says “FileMaker is a great tool to create apps quickly and implement them immediately 
and also to improve the apps easily.” 

Providing Medical Documentation via FileMaker Go

Henry Schein Dental is one of the largest worldwide providers of healthcare products and services 
to dentists, doctors, and veterinarians. Sales consultants are armed with a custom sales literature 
app created in FileMaker Pro and running on FileMaker Go for iPad. The app lets them search 
through thumbnails, pull up pertinent literature, order a PDF or print version, and hand over 
personalized, "just-in-time" sales materials on the spot.  

For sales consultants who do not yet have an iPad, Henry Schein Dental uses the FileMaker API for 
PHP to deliver the same custom sales literature app via the web browser on their desktop or 
laptop computers. As a result, speed of customer communication and knowledge of the available 
sales tools have improved significantly. 

On the back end, FileMaker Server tracks quantities of sales materials to determine exactly what 
needs to be printed, saving potentially tens of thousands of dollars previously wasted on 
overstocked, never-used brochures. Jon Baucom, Director of Marketing, and others on the 
marketing team can use FileMaker Pro on Windows and Mac computers to generate reports 
automatically and to chart inventory levels and popularity of specific pieces to continually improve 
and streamline the production process. 
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LESSON 1


Section 6: Get Started Options

It is recommended that you review the Get Started options built into FileMaker Pro prior to 
proceeding with the rest of the FileMaker Training Series: Basics, including the FileMaker Pro 
Tour. 

While the FileMaker Pro Tour covers foundational information about FileMaker Pro, the FileMaker 
Training Series: Basics will cover those topics and many others in much more depth.  

You can access the Get Started window in FileMaker Pro from the File Menu (as shown in Figure 
4). 

� 

FIGURE 4


If you scroll to the bottom of this window, you’ll see a Tour FileMaker Pro button, which launches 
the FileMaker Pro Tour. 

In the FileMaker Pro Tour, you learn about: 

• Creating and editing records 

• Importing data from Excel 

• Finding, sorting, and exporting data 

You can access a similar Welcome Tour in FileMaker Go upon opening it the first time or by 
tapping on Welcome Tour in the Options screen, as shown in Figure 5. 
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FIGURE 5
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Lesson 1: Review Questions

1. Describe two real-world use cases of a FileMaker app. 

2. What is the recommended way to share a FileMaker app with multiple users? 

3. Explain the software and hardware you need to design and build a FileMaker app. 

4. When do you need to purchase concurrent connections? 

5. Describe the two methods by which FileMaker Go can access a FileMaker app. 
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Lesson 1: Review Answers

1. Musashino Corporation manages seminars, through a Seminar Progress Management 

app on the FileMaker Platform. Staff can check their tasks and help others with their 
tasks. Market Refrigeration Specialists installs and maintains large refrigeration and 
HVAC systems. With FileMaker Go for iPad, field technicians process work orders, time 
cards, and parts requests. 

2. The best way to share a FileMaker database with multiple users is by hosting the file on 
FileMaker Server. 

3. In order to design and build a FileMaker app, you need FileMaker Pro or FileMaker Pro 
Advanced running on a Mac or Windows computer. 

4. You need to purchase concurrent connections for FileMaker Server when you have 
users accessing your app from iPad, iPhone, or a web browser. 

5. FileMaker Go can access FileMaker apps that are stored locally on an iOS device, or it 
can access hosted apps over Wi-Fi or a cellular network connection. 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Lesson 2: Using Starter 
Solutions
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Lesson 2: Using Starter Solutions

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Objectives

After this lesson, you will be able to: 

• Determine when a Starter Solution best fits your needs. 

• Understand why Starter Solutions are useful for desktop and mobile development. 

• Create a file that is accessible on your iOS device through FileMaker Go. 

There are three primary methods for creating an app: beginning with a Starter Solution and 
modifying it to meet your needs, importing data from another source, and creating an app from 
scratch. 

This lesson will explain how to create an app by using a Starter Solution. 

FileMaker Pro comes with 16 built-in Starter Solutions, which are professionally designed templates 
customized for managing tasks on iPad, iPhone, desktop, and the web. In minutes, you will be 
able to get started managing contacts, assets, content, invoices, and more. Plus, you can easily 
modify the Starter Solutions for your specific needs. 
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LESSON 2


Section 1: Choose a Starter 
Solution

Starter Solutions are fully built FileMaker apps that allow users to manage many different types of 
information. They are also easily customizable by adding fields, rearranging layouts, and even 
copying or importing elements from a different Starter Solution. 

To use a Starter Solution, simply select Get Started… (in the File menu). Select an app, save it to 
your desktop, then explore the template by entering data. 

The following table summarizes the features, the development skill level, and the data that can be 
stored for each of the Starter Solutions. 
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Starter Solution Skill Level Features

Assets Beginner Tracks office assets and other 
depreciable items. Fields include: 
asset category, serial number, 
and purchase date. Calculates 
depreciation using the straight-
line method.

Contacts Beginner Manages complete contact 
information for all your business 
relationships, including multiple 
addresses, phone numbers, 
email address, and more.

Content Management Beginner Tracks different media files and 
relevant categorical and status 
information, as well as details 
about their revision history.

Expense Reports Intermediate Tracks and reports reimbursable 
expenses.

Inventory Intermediate Tracks inventory items, including 
category, value, and more. Also 
tracks stock transactions and 
company information.

Meetings Intermediate Monitors meeting minutes and 
summaries, as well as action 
items and responsible parties.

Personnel Intermediate Manages employee data such as 
hire date, salary, manager, time 
off and date of next review. 
Integrates the information with 
the Expense Report template for 
more detailed information on 
every employee.
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Projects Intermediate Manages project descriptions, a 
history of active and completed 
tasks, and all personnel 
associated with an assignment.

Research Notes Intermediate Compiles and organizes all 
research notes in one location. It 
also helps track web search 
notes.

Resource Scheduling Intermediate Manages the scheduling and 
commitment of resources.

Time Billing Intermediate Calculates hours worked, hours 
billed, and the hourly rate for 
each employee on a weekly 
basis. Provides a way to track 
billing by customer.

Estimates Advanced Manages data for customer 
estimates, such as products, 
terms, discounts, tax rates, and 
more—and keeps track of how 
the information relates to both 
relevant customers and 
products. Easily prints estimates.

Event Management Advanced Tracks event details including 
tasks, agenda, invitees/guests, 
contributors, gifts, and thank you 
notes.

Invoices Advanced Similar to the Estimates 
template, but with data targeted 
toward invoicing needs. 
Manages contacts, products, 
and invoicing. Great for small 
businesses.

Starter Solution Skill Level Features
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Tasks Advanced Tracks tasks and their owners for 
any project, and instantly access 
details through each step.

Starter Solution Skill Level Features
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LESSON 2


Section 2: Quick Mobile 
Development

If you want to create a FileMaker app accessed by both FileMaker Pro and FileMaker Go users, 
many of the Starter Solutions provide an excellent framework for mobile use with FileMaker Go. 
Each has been designed to detect the device used to access it and then display an optimized 
interface for that device. Personnel Records, Research Notes, and Time Billing all have specific 
iPad layouts—and the other solutions have layouts that are designed for both iPad and iPhone. 
The Starter Solutions take advantage of Multi-Touch Gestures, allowing users to swipe to view 
more data and to navigate between records. 

Complete the following activity to learn some of the features of Starter Solutions that are optimized 
for iOS. 

Activity 2.1: Exploring the Event Management Starter Solution

1. Open FileMaker Pro 15. The Launch Center opens automatically—if it does not, select 

Open… in the File menu. 

2. Choose New..., New from Starter Solution…, then choose Event Management. 

3. Name the file "Event Management.fmp12” and save it to your desktop. After the file 
is saved, the app opens to the Events Details layout. 

4. Click on the existing event and enter some test data of your own in the record that the 
app created. 

5. Click on the Tasks tab, click on Add Task, then add a few tasks, as pictured in Figure 
6. 
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FIGURE 6


6. Close the file. 
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Lesson 2: Review Questions

1. If you need to create an app that keeps track of customers, products, and purchase 

orders, which Starter Solution should you use? 

2. Which template would you use to build an iPad app for a scientist who needs to collect 
lab notes? 

3. What are the main differences between the Starter Solutions for Assets and Inventory? 

4. Describe one possible use of the Starter Solution for Content Management. 

5. What are three features that make Starter Solutions so helpful to mobile development? 

6. Which Starter Solution helps track an employee’s time off? 
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Lesson 2: Review Answers

1. The Starter Solution for Invoices works best in this situation—to keep track of 

customers, products, and purchase orders. 

2. Research Notes is ideal for this app. 

3. The Assets solution tracks office assets and other depreciable items. Its fields include 
asset category, serial number, and purchase date. It calculates depreciation using the 
straight-line method. The Inventory solution tracks product inventory items, including 
category, value, and more. 

4. The Content Management solution tracks different media files and relevant information 
such as categories and status, as well as details about their revision history. It can be 
used for images, documents, videos, and much more. 

5. Three features that make Starter Solutions helpful to mobile development are:  they 
automatically show a layout optimized for each device; they are built with layout 
features that optimize space and viewing on mobile devices; and they were designed 
for easy data entry and take advantage of Multi-Touch gestures. 

6. Personnel Records helps track an employee’s time off. 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Lesson 3: Viewing and Working 
with Data
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Lesson 3: Viewing and Working 
with Data

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Contacts.fmp12 

Objectives

After this lesson, you will be able to: 

• Describe the function of a layout, giving examples of when different layouts might be 
needed. 

• Decide when to use the four modes available to users of a FileMaker app. 

• Compare and contrast the three layout views. 

• Describe two methods used to navigate between records. 

• Create a new record. 

• Add, modify, save, and delete data. 

Next you will use a version of the Contacts Starter Solution with data in it to help you navigate, 
organize, and work with data in a FileMaker app. In this lesson, you will learn about layouts, 
records, different modes to work with your app, and different ways to view and edit your data. 

Here is what you learned from the FileMaker Pro Tour. 

Basics > Records & Fields


• A database file is organized into tables, tables contain records, and records contain 
fields, which store the actual data. 

• Fields can store various types of data, including text, numbers, dates, and images. 
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Basics > Viewing Data


• FileMaker Pro displays fields on layouts. 

• Databases can have many kinds of layouts, used for viewing forms or reports, printing 
labels, entering data on iOS devices, and more. 

• Browse, Layout, Find, and Preview are four modes available to users. 

• You can display layouts in List view, Table view or Form view. These are layout views. 
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LESSON 3


Section 1: Layouts

Layouts provide the user interface for a FileMaker app and organize how you see information. 
Layouts do not store data. Instead, whether you are entering data or printing reports, layouts 
handle how that data is displayed. You can create many layouts to see the same record—or set of 
records—in different ways. For comprehensive instruction about layouts, refer to Lesson 9. 

Switching Layouts

To move to different layouts with FileMaker Pro, use the Layout pop-up menu (shown in Figure 7). 
To change layouts in FileMaker Go, click on the icon in the upper left corner and choose Layout. 
The next screen, shown in Figure 8, allows you to choose the layout you wish to view. 

� 

FIGURE 7
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FIGURE 8


When you switch to a different layout, you might see the same records or a different set of records 
depending on the context of the layout. For example, you might start with a Contact Details 
layout that shows each contact as a form, then switch to a Contacts List layout that shows the 
same found set of contacts as a list. Then, you might switch to a Company List layout that shows 
a found set of company records as a list. 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LESSON 3


Section 2: Modes Within 
Layouts

In FileMaker Pro, the modes are Browse mode, Find mode, Layout mode, and Preview mode. 
You can change the mode with a keyboard shortcut, through the View menu, or the pop-up menu 
at the bottom of the window as shown in Figure 9. 

� 

FIGURE 9


In FileMaker Go, only Browse mode and Find mode are available. 

Browse mode

You will use Browse mode to do most of your work, including all data entry and viewing. You can 
add, view, edit, sort, omit (hide), and delete records. 

The keyboard shortcut is Command-B in OS X or Ctrl-B in Windows. 

Find mode

You can search for records that match a set of criteria in Find mode. First you enter your search 
criteria, then perform the search, and finally FileMaker Pro returns to Browse mode, displaying all 
the records that match the criteria. You can then work with this set of records, which is generally 
referred to as the "found set.” The keyboard shortcut to enter Find mode is Command-F in OS X 
or Ctrl-F in Windows. 

In FileMaker Go, to enter Find mode, tap the magnifying glass button, then choose Create New 
Find as shown in Figure 10. 
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FIGURE 10


You’ll learn how to use Find commands in Lesson 4. 

Layout mode

To modify layouts and provide users with different interfaces to access data, you will use Layout 
mode. FileMaker Pro uses Layout mode to show information both on a screen and in printed 
materials. This mode is not available in FileMaker Go and FileMaker WebDirect. 

The keyboard shortcut is Command-L in OS X or Ctrl-L in Windows. 

Preview mode

To see how data looks before you print it, use Preview mode. This mode is especially helpful to 
view layouts with multiple columns, and reports with headers and footers. This mode is not 
available in FileMaker Go and FileMaker WebDirect. 

The keyboard shortcut is Command-U in OS X or Ctrl-U in Windows. 
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LESSON 3


Section 3: Views Within Layouts

You can display a layout using one of three views. In FileMaker Pro, select the view from the View 
menu or from the Status Toolbar shown in Figure 11. In FileMaker Go, you can access the View As 
options, shown in Figure 12, by tapping the icon in the upper left of the screen and choosing 
Layout. 

� 

FIGURE 11
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FIGURE 12


�43



FileMaker Training Series: Basics for FileMaker 15

View as Form

To view and modify records individually, use Form view. Though you might have multiple records in 
the found set, you see only one record at a time in Form view. 

View as List

You see a scrollable list of records in List view. Scroll up and down to browse through records. The 
number of records you can see at one time depends on the structure of the layout. The current 
record is indicated by row highlight or a thin, black bar at the left of the record and is the record 
that will be affected by commands such as Delete Record or Duplicate Record. When you are 
in List view, you can click or tap a record to make it the current record. 

View as Table

People who use spreadsheets will discover that Table view looks very familiar. Data fields are 
represented as columns, and the records are represented as rows. Table view can be quite 
powerful because you have easy access to resize, reorder, sort, and hide columns, and to view 
summary data. 
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LESSON 3


Section 4: Records

You can navigate between records in many ways. In FileMaker Pro, the Status Toolbar includes 
buttons for Next Record and Previous Record and a slider shown in Figure 13. In FileMaker Go, 
you move between records by using the left and right arrows, or by clicking on the #  icon and 
using the slider shown in Figure 14. While on a layout in Form view, you can also use a two finger 
swipe in FileMaker Go, touch enabled Windows tablets, and Mac OS trackpads. The Status 
Toolbar shows the current record number, the number of records in the set (if applicable), and the 
sort status. 
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FIGURE 13
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FIGURE 14


Activity 3.1 – Moving Between Layouts and Records

Practice moving between layouts and records using the methods that were described in this 
lesson: 

1. Open the Contacts.fmp12 file in FileMaker Pro. The file will open to the Contact 
Details layout. Which view is shown? 
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2. Switch to the Desktop > Contacts layout using the Select Layout pop-up menu. 
Which view is shown? 

3. Move three records ahead by clicking the Next button from the Status Toolbar. The 
destination record is Cynthia Butler. 

4. Use the slider to go to the last record. The record should be for Steve Williams. 

5. Use the scroll bar on the right side of the window to scroll to the top of the window. 
Notice that this action does not change the current record. 
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LESSON 3


Section 5: Working With Data

When you use FileMaker Pro or FileMaker Go, you enter and interact with data in Browse mode. 

Creating a New Record 
When entering new data, you will first create a new record. In FileMaker Go, tap on the plus/minus 
button and tap Add New Record, as shown in Figure 15. 

� 

FIGURE 15
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There are several ways to create a new record in FileMaker Pro. You can choose New Record 
from the Records menu, click the New Record button in the Status Toolbar as shown in Figure 
16, or use the keyboard shortcut Command-N for OS X or Ctrl-N for Windows. 

FIGURE 16


Duplicating a Record 
Duplicating a record can be an efficient way to create a new record. For example, if two people live 
at the same address, you can duplicate one person’s record and then change only the information 
that is different about the second person, such as their name. In an Event Management database, 
you can duplicate a record to create new records for events that are similar to each other, again 
changing only the details that differ. 

To duplicate a record in FileMaker Go, tap on the plus/minus button and tap Duplicate Record as 
shown in Figure 17. 
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FIGURE 17


In FileMaker Pro, choose Duplicate Record from the Records menu or use the keyboard 
shortcut Command-D for OS X or Ctrl-D for Windows. 

Modifying Data 
To enter data in a field in FileMaker Go, first tap in the field to make it active. Then use the Next 
and Previous buttons above the keyboard to move through the fields. In FileMaker Pro, click in a 
field or use the Tab key to move from field to field. Shift-Tab will move you backwards through the 
tab order. 

Some fields may require different types of data entry. Many fields are formatted as edit boxes that 
allow you to enter data. Other fields will have pull-down menus, radio buttons, or checkboxes to 
select data. If a field is set as a date, time, or timestamp, you must enter a valid value. 

Saving Data 
When you enter data, the record is not saved, or committed, to the file until you take one of five 
actions: 
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• Change modes 

• Change to a different record 

• Change to a different layout 

• Click or tap outside of all fields in the record (such as the background) 

• Close the window 

While, by default, changes you make to the data are saved automatically as you work, you can 
configure any layout so that you are asked to confirm record changes first. In the General tab of 
the File > Layout Setup dialog shown in Figure 18, uncheck Save record changes 
automatically. 

� 

FIGURE 18


Deleting Data 
Deleting a record in a FileMaker file is permanent. You cannot restore the data or undo the delete. 
To delete a record in FileMaker Go, tap the plus/minus button and tap Delete Record as shown in 
Figure 19. 
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FIGURE 19


In FileMaker Pro, choose Delete Record from the Records menu, click the Delete Record 
button in the Status Toolbar, or use the keyboard shortcut Command-E for OS X or Ctrl-E for 
Windows. 

In both FileMaker Pro and FileMaker Go, a dialog will ask you to confirm that you want to delete the 
record permanently. 

Activity 3.2 – Creating New Records and Entering Data in 
FileMaker Pro

Practice creating new records and editing data in the Contacts Starter Solution. 

1. Open Contacts.fmp12 and navigate to the Contact Detail layout. 

2. Click the New Record button in the Status Toolbar. 

3. Fill out the new record with your contact information. Use the Tab key on the keyboard 
to navigate between fields. 
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4. When finished, click on the background of the layout where there are no objects. This 
will save the record. 

5. Delete your record by either clicking Delete Record in the Status Toolbar, or going to 
Records > Delete Record. 

6. When asked to Permanently delete this ENTIRE record, click Delete. 

�52



FileMaker Training Series: Basics for FileMaker 15

Lesson 3: Review Questions

1. If you want to view a database like a spreadsheet, which view should you use? 

2. When you are browsing records in FileMaker Go, how can you move to the next 
record? 

3. Which mode would you use to create a new record? 

4. What are three ways that you can save, or commit, a record? 

5. How many users can modify a record at once? 

6. Can deleting a record be undone? 
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Lesson 3: Review Answers

1. The Table view shows the fields in columns and records in rows. 

2. You tap the Next and Previous buttons to move between records or use a two finger 
swipe motion in FileMaker Go 15. 

3. Use Browse mode to create a new record. 

4. You can commit a record by changing layout, changing mode, changing record, or 
clicking or tapping outside all the fields of the current record. 

5. Only one user can modify a record at a time. Another user cannot modify the record 
until it has been committed. 

6. No, deleting a record cannot be undone. The only way to recover the data would be to 
import the record from a backup of the database.  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Lesson 4: Finding and Sorting 
Records
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Lesson 4: Finding and Sorting 
Records

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Contacts.fmp12 

Objectives

After this lesson, you will be able to: 

• Perform complex finds. 

• Extend and constrain found sets. 

• Make use of operators in your search requests. 

• Sort records. 

In the FileMaker Pro Tour in FileMaker Pro, you learned how to perform basic searches using 
Find mode and how to perform quick searches using Quick Find.  

In this lesson, you will learn how to do more complex searches. 

Here is what you learned from the FileMaker Pro Tour. 

Basics > Finding Data


• Use Find mode to search for records containing data stored in specific fields. 

• Use Quick Find to search across all fields on the current layout. 

Basics > Sorting Records


• Sorting changes the order in which data is displayed. 

• You can sort data by multiple fields to group records. 
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LESSON 4


Section 1: Specifying Search 
Criteria

When performing a simple search, FileMaker by default performs a "words begin with" search. This 
means that the field you are searching can contain: 

• Longer words that begin with the values you specify 

• Other words in addition to the ones you specify 

• Values in any order 

For example, if you were to enter "mary" as the search criteria in a First Name field, your found set 
will include records for Mary, Mary Beth, Maryann, and Rose Mary. But it will not find Rosemary or 
Jomary. Note that searches are not case sensitive (unless the indexing of the field is set to 
Unicode). 

The quickest way to search is to use the contextual shortcut menu to find matching data in a 
particular field. Right-click (or Control-click) a field that has the criteria you want. Choose Find 
Matching Records from the shortcut menu and FileMaker Pro finds records that have the same 
value in that given field. 

Activity 4.1: Contextual shortcut for Finds

Find records matching the Company field for West Side Antiques. 

1. In the Contacts file, go to the Contact Details layout. 

2. Click Show All in the Status Toolbar, if necessary, and navigate back to the first record. 

3. Right-click or Control-click in the Company field containing “West Side Antiques” 
and a pop-up menu appears. 

4. Choose Find Matching Records. Your new found set includes 6 contacts that work 
for "West Side Antiques". 

Performing AND or OR Searches 
Sometimes it is helpful to find data based on multiple criteria—for example, all contacts that are 
Artists at Rankin Studios. This can be done in Find mode by entering criteria into each relevant 
field, in this case Job Title and Company. The search results will be comprised of records that 
match all the criteria you entered. This is known as an AND search. 
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On the other hand, what if you want to search for people who work at either of two different 
companies? Rather than using multiple fields in a single search request, as you do when you 
perform an AND search, you use multiple requests to perform an OR search. This allows you to 
submit different values into the same field, in this case the Company field. 

Activity 4.2: Performing AND and OR searches

Perform an AND find for Contacts who are Artists at Rankin Studios. Then perform an OR find for 
Contacts who work at Kristi's Auctions or Williams Design Studio. 

1. On the Contact Details layout, enter Find mode by choosing Find mode from the 
View menu. 

2. Enter "Rankin Studios" into the Company field and "Artist" into the Job Title field. 
Entering search terms into two or more fields within the same find request creates an 
AND find. 

3. Click Perform Find in the toolbar. All artists at Rankin Studios are returned. 

4. Enter Find mode again. This time you will create an OR find by using multiple find 
requests. 

5. Enter "Kristi's Auctions" into the Company field. 

6. Click New Request in the Status Toolbar, and enter “Williams Design Studio” into 
the Company field. 

7. Click Perform Find in the toolbar.  

8. Switch to the Contacts layout in the upper left. Notice 8 contacts work for Kristi's 
Auctions or Williams Design Studio. 
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LESSON 4


Section 2: Extending and 
Constraining a Found Set

When performing a new search, FileMaker Pro searches all records and replaces your previous 
found set with a new found set. This works well for most searches, but occasionally it is necessary 
to search within a found set or to add records to your current found set. FileMaker allows users to 
either extend or constrain the existing found set with the following menu options: 

• Extend Found Set: When you extend your found set, the omitted records are 
searched. Any omitted records that match the search criteria are added to the current 
found set. 

• Constrain Found Set: When you constrain your found set, the search is performed 
only on the records in the current found set, rather than all the records in the table. Any 
records in the current found set that match the search criteria are returned. 

Both the Extend Found Set and the Constrain Found Set options are in the contextual shortcut 
menu and the Requests menu. 

Activity 4.3: Extending a Found Set

Perform a find for Contacts in the Friend group, then extend your found set to include Contacts in 
the Personal group. 

1. On the Contact Details layout, enter Find mode. 

2. Enter "Friend" in the Group field and perform the find. Notice the found set is 13 
records. 

3. Go back into Find mode and enter "Personal" in the Group field. 

4. Choose Requests > Extend Found Set. Your results include 26 contacts in either the 
Personal and Friend groups. 

Note: Using Extend Found Set is the equivalent of performing an OR search. 

Activity 4.4: Constraining a Found Set

Perform a find for Contacts that work at West Side Antiques, then constrain your found set to only 
Assistants. 

1. On the Contact Details layout, enter Find mode. 

2. Enter "West Side Antiques" in the Company field and perform the find. Your results 
should include 6 records. 
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3. Go back into Find mode and enter "Assistant" in the Job Title field. 

4. Choose Requests > Constrain Found Set. You will see 3 contacts who are 
Assistants at West Side Antiques. 

Note: Using Constrain Found Set is the equivalent of performing an AND search. 
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LESSON 4


Section 3: Using Operators in 
Search Criteria

An operator is a symbol or instruction that gives you more flexibility with your search criteria. For 
example, you can search a date range by entering two dates separated by the range operator (…). 

When you enter Find mode, you will see that the Status Toolbar contains a drop-down menu 
labeled "Insert: Operators” (Figure 20). You can either choose an operator from the drop-down 
menu or you can enter it with the keyboard. 

� 

FIGURE 20


Operators are helpful for finding ranges of dates, times, and numbers, using “wildcards” to find 
partial matches in text searches, or changing FileMaker’s default “words begin with” behavior. They 
are also used to search for records where a given field is either empty or has data. 
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Activity 4.5: Finding Empty Fields

Perform a search to find Contacts without a mobile phone number. 

1. On the Contact Details, enter Find mode. 

2. Enter "=" in the Mobile field. 

3. Click Perform Find in the toolbar, or press the Enter key. The found set should 
contain 35 contacts without a mobile phone number. 

Activity 4.6: Finding Non-Empty Fields

Perform a search to find Contacts with a personal phone number. 

1. On the Contact Details, enter Find mode. 

2. Enter "*" in the Personal phone field. This tells the database to find records where the 
field content is not empty. 

3. Click Perform Find in the toolbar, or press the Enter key. The found set should 
contain 37 contacts with a personal phone number. 

Finding Strings of Characters in a Field 
Another way of using the asterisk (*) operator is to modify the "word begins with" behavior of Find 
mode. For example, you can find all values in a First Name field that end with "eth" by using *eth as 
your search criteria. This search would find people such as Beth and Elizabeth, but it would not 
find Bethany. 

If you want to find values in a First Name field that include "eth" anywhere in the value, your 
search criteria should be *eth*. This will find any values that start with, include, or end with "eth," so 
it would also find people such as Beth, Elizabeth, and also Bethany. 

Finding a Range of Data 
When you work with numbers, dates, and times, you may want to search for data in ranges. For 
example, suppose you want to find all orders shipped from the start of January to the end of March 
in 2015, or all items over $500. To perform such searches, use operators like greater than (>), less 
than (<), or an ellipsis (…). 

Find mode has four operators to help find data before or after a specific value: greater than (>), 
greater than or equal to (≥), less than (<), and less than or equal to (≤). In Find mode, place any of 
these operators before the value. For example, to find all assets over $500, place “>500” in the 
cost field. 

The ellipsis (…) allows users to find data between two values. For example, in order to find dates 
between the beginning of January and the end of March, enter 1/1/2015…3/31/2015 in the Ship 
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Date field. You can select the ellipsis from the operators pop-up menu (Figure 20), type three 
periods, or type Option–; (Option–semicolon) on OS X. 

Finding Exact Data 
While the default "word begins with" logic is usually helpful in finding data quickly, it can return 
more records than you might want. For example, searching for "North" in a Region field results in 
values like "North," "Northwest," and "Northeast." 

• Exact field match: To be more specific in a search, use two equal signs (==) to obtain 
an exact field match. Entering "==North" in the Region field shows only those records 
that have the exact value "North". 

• Exact word match: One equal sign (=) performs an exact word match. For example, 
"=North" results in records containing "North" and "North Pole," but not “Northeast." 
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LESSON 4


Section 4: Sorting Records

Whether you are looking at all records or a found set, it is often helpful to sort your data. For 
example, you could sort contacts alphabetically by Last Name, or sort invoices in ascending date 
order by their Ship Date. By default, records display in the order in which they were created in the 
table.  

To open the Sort Records dialog (Figure 21), click Sort in the Status Toolbar, or use the keyboard 
shortcut Command-S (OS-X) or Ctrl-S (Windows). 

� 

FIGURE 21


Choosing Sort Fields 
In the Sort Records dialog box, the left side contains a list of all the fields on the current layout. By 
clicking Current Layout (…), you can choose to sort on other fields in the app. 

To add a field to the sort order, double-click the field name in the list, or select the field and click 
Move. You can sort by one field or multiple fields. In Figure 22, the data sorts by Last ascending, 
then First ascending. 
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FIGURE 22


Setting Sort Order 
The icon to the right of the field in the Sort Order box indicates how the data will sort. To specify 
ascending or descending sort order for a field, select the field in the Sort Order pane and choose 
Ascending order or Descending order using the radio buttons in the middle of the dialog. You 
can also click the Unsort button at the bottom of the dialog, which returns the records to creation 
order. 
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Lesson 4: Review Questions

1. Describe two ways that you can perform AND searches. 

2. How can you find all records with an empty field? 

3. What operators allow finding of ranges of dates, times, and numbers? 

4. In what order do records show if they are not sorted? 
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Lesson 4: Review Answers

1. Two ways to perform AND searches: 

• Type criteria into multiple fields in one single search request. 

• Perform a simple search, and then narrow the found set by using Constrain 
Found Set through the application menu or the contextual shortcut menu. 

2. To find all records with an empty field, use the = sign in Find mode in the field. 

3. The operators for finding ranges of dates, times, and numbers are: Greater than (>), 
Greater than or equal to (≥), Less than (<), Less than or equal to (≤), and Ellipsis (…). 

4. Records will show in the order they were created when they are not sorted. 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Lesson 5: User-Centered Design
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Lesson 5: User-Centered Design

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Contacts.fmp12 

Objectives

After this lesson, you will be able to: 

• Identify the steps of the design process. 

• Describe your user’s goal as a one-sentence problem statement. 

• Understand the needs of the fictitious company “Equipment Providers, Inc.” used in the 
rest of the lessons of this training program. 

User-centered design is an established methodology for designing software interfaces that involves 
the eventual users of the software in each stage of the design process. It forces developers to 
focus on the user—and to step away from the computer. 

Here, the aim of user-centered design is to build FileMaker apps that focus on users’ goals, not 
features. By focusing on goals, you will ensure that your app is solving the right problems, therefore 
making your users more confident and successful. 
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LESSON 5


Section 1: What is User-
Centered Design?

The developers that are making a difference in the world are taking great technologies and shaping 
them with user-centered design. 

Three Basic Principles 
The basic principles of user-centered design are: 

1. Observe users’ goals, behaviors, mental models. 

2. Make technology serve users, not the other way around. 

3. Test with users by giving them a natural goal and observing what they do. 

If you are doing user-centered design correctly, you will be repeating this process over and over 
again until you identify what really meets the users’ expectations. 

Think Goals Not Features 
Start by understanding what the user wants to achieve, not the features you think the user needs.  

Why? Because goals are much more descriptive than features. For example, consider a Porsche 
and a riding lawnmower. They have many of the same features, including an internal combustion 
engine, four wheels and rubber tires, a transmission, and a steering wheel. But when described in 
terms of goals, the lawnmower cuts grass evenly while the driver is seated comfortably. That’s not 
typically what people want to do with a Porsche. 

Think Differently 
Building an app begins with the user-centered design process, not with development in FileMaker 
Pro. By stepping away from the computer, you free yourself to think and act differently during the 
design process. 

Find ways to free up your imagination: do some "whiteboarding" with users, and find inspiring 
design patterns from other places, like the Starter Solutions or your favorite apps. 

Build up your knowledge: a solid understanding of what is possible with the FileMaker Platform will 
help you come up with better ideas. 

Don’t be intimidated by user-centered design. Adopt one, two, or a few of these practices and 
grow from there. 
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LESSON 5


Section 2: Basic Principles

Observe users — their goals, behaviors, and mental models

Taking the time up front to understand your audience and their needs is the first step in designing a 
truly useful and usable app that your users will love. Put yourself in their shoes and get to know 
their job roles from the inside out. 

Describe your user’s goal as a one-sentence problem statement: 

Design a [form of app] 
For [user type] 
To [human activity] 
With [level of support] 

For example, for a hospital, the statement might be: 

Design a [kiosk application] 
For [urgent care patients] 
To [sign in] 
With [speed] 

Your users will likely have more than one goal. Write down all your users’ goals and their problem 
statements. You may have users with different goals and you will need to prioritize which problems 
are the most important. However, don’t try to solve every problem at once. Solve a simple problem 
first, then, gradually add complexity. 

Sketches, whiteboards, wireframes, and flowcharts can be helpful in communicating what you 
have learned. Allow yourself to be creative and observe your users. 

Make technology serve users — not the other way around

The FileMaker Platform gives you many tools to simplify the user experience. But like any tool, it 
can be used in many different ways. Your design choices will determine how users react to your 
app. 

Test with users — give them a natural goal, then sit back and 
watch

Prototypes may start as flowcharts and whiteboards, but they will evolve into something your users 
can actually use. During this phase, be flexible and allow your ideas and apps to change. Ask for 
feedback from users and have a discussion on what the app lacks and offers for the users. During 
this whole process, revisit previous steps. The design process involves multiple iterations in order 
to create a successful app. 
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LESSON 5


Section 3: Equipment Providers, 
Inc.

Throughout the rest of the FileMaker Training Series: Basics, you will be learning FileMaker by 
building an app for a fictitious company, Equipment Providers, Inc. The company rents office 
equipment to a number of customers. you will start by going through the steps of the user-
centered design process. 

Observe users — their goals, behaviors, mental models

The Equipment Providers, Inc. management team has noticed that many assets are not being 
tracked properly. While employees try to track data in an Excel spreadsheet, they are not 
consistent about it. Occasionally, employees will write asset details on a sticky note and ask the 
company’s administrative assistant to type the data into the spreadsheets, but the notes get lost 
among other paper or accidentally thrown away. 

A review of the data reveals that it’s often misspelled or entered inconsistently. For example, the 
Asset category column shows mismatched terms like "Office Furniture" and "Furn.: Office", making 
it difficult to group and sort the data properly. 

When it comes to the Customer information, most of the existing information is out of date. 
Employees depend on their own address books instead of the spreadsheet, which limits shared 
access by other employees. Additionally, Customers are required to sign a paper copy of the Asset 
information to confirm that they received the asset. These paper copies are rarely placed in the 
filing system in a timely manner—usually 3 to 4 weeks after being signed. In other words, the 
current spreadsheets in place are either missing data or outdated. 

This fictitious example has the following primary one-sentence problem statement: 

Design a [customer asset tracking app] 
For [the operations team] 
To [know which customers have which assets] 
With [speed and accuracy] 

In addition, the following elements are relevant: 

• Currently the customer and asset data is stored in Excel spreadsheets. 

• It will be important to know when an asset was purchased, when it was given to the 
customer, and how much the asset cost. 

• When the customer receives the asset, a signature is required. Currently, a form is 
printed out with asset details and the customer signs the form. However, all employees 
carry iOS devices provided by the company, so the best plan would be to leverage 
those devices for signing out assets. 
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• Users want the ability to add notes to a given asset. Notes can be anything from details 
about the asset (color, size, etc.) to damage information recorded when the asset is 
returned by the customer. It would be best if the user could type information into a 
notes field. 

• It is imperative to know how long a customer has leased each asset. 

• It will be important to know the total cost of a customer’s assets. 

• Users, except for the Admin account, should not be able to modify customer 
information. All users can edit asset data. 

• Users cannot delete any customers or asset records. 

• Pushing the data to the web would be useful so that customers can see a list of the 
assets they have. 

• It would be helpful to have a report that provides all assets by customer and the total 
cost per customer. 

Based on the relevant points observed about the Equipment Providers, Inc. scenario, there may be 
additional one-sentence problem statements. Here are a few others to consider: 

Design an [iPad workflow] 
For [a delivery worker]  
To [get a customer’s signature] 
With [security and reliability] 

Design a [method of inputting data] 
For [an operations team member]  
To [take notes about an asset] 
With [speed and portability] 

Design a [report]  
For [an administrative assistant] 
To [view assets for customers and their total cost]  
With [up to date information] 

Make technology serve users — not the other way around

Employees deliver and install equipment onsite. Most of the sites are office buildings. A signature is 
collected from the customer to verify that the equipment was properly delivered and installed. For 
these reasons, it would be easier for these employees to access the app from iPhone or iPad 
rather than from a computer. 

The employees have a lot of deliveries and installations during the day so they need an app that 
requires very little time to view and record information. 

As you continue through the training, you will build an app for Equipment Providers, Inc. while 
learning about data, user interface, app logic, reporting, integration, security, and deployment. 
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Lesson 5: Review Questions

1. What are the three basic principles of user-centered design? 

2. What is the template for a one-sentence problem statement? 

3. What is the primary one-sentence problem statement for the employees of the fictitious 
company, Equipment Providers, Inc.? 
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Lesson 5: Review Answers

1. First, observe users taking note of their goals, behaviors, and mental modes. Next, 

make the technology serve users, not the other way around. Lastly, test with users by 
giving the natural goals, and watch their behaviors. 

2. Design a [form of app] 
For [user type] 
To [human activity] 
With [level of support] 

3. Design a customer asset tracking app 
For Operations 
To know which customers have which assets 
With speed and accuracy  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Lesson 6: Importing Data

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson Files

Customers.xlsx, Assets.xlsx 

Objectives

After this lesson, you will be able to: 

• Identify common file formats that can be converted by FileMaker Pro. 

• Convert a supported file format into a FileMaker app. 

• Convert an Excel workbook with multiple worksheets into a single FileMaker app. 

There are three primary methods for creating an app: beginning with a Starter Solution and 
modifying it to meet your needs, importing data from another source, and creating an app from 
scratch.  

In this lesson, you will begin to build the app for Equipment Providers, Inc. by importing data from 
two spreadsheets. 

In the FileMaker Pro Tour you learned: 

Basics > Importing Records


• You can import data from another FileMaker Pro file or from another application, such 
as Microsoft Excel. 

• When you import, you can add new records to your database or update data in existing 
fields. 
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LESSON 6


Section 1: Converting an 
Existing File

FileMaker Pro can import many different file formats. This is useful because the conversion process 
automatically creates tables, fields, and records, reducing the number of steps required to get 
started using FileMaker Pro. It also removes the need to manually input information that you 
already have. File formats that will convert directly into FileMaker files include: 

• Microsoft Excel files (.xls or .xlsx) 

• Tab-separated text files (.tab or .txt) 

• Comma-separated text files (.csv or .txt) 

• Merge files (.mer) 

• dBASE files (.dbf) 

Other file types will need to be converted to one of the supported file formats before they can be 
converted to .fmp12. For example, the records from a Microsoft Access database (.mdb) can be 
exported as Microsoft Excel files. 

You may need to clean up your spreadsheets to make the transition to FileMaker Pro easier. For 
example, include a header row (which FileMaker Pro will interpret as field names), remove any 
blank rows, and remove any subtotal or total rows (since FileMaker Pro allows you to create 
necessary fields to show summarized data). 
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LESSON 6


Section 2: Converting Excel 
Files

An Excel spreadsheet is one of the most frequently imported file types.  

FileMaker retains Excel data types such as text, numbers, dates, etc. when data is imported. If a 
column of data in the original spreadsheet is a mix of data types, FileMaker Pro will import that 
column as text. 

In the case of Equipment Providers, Inc., you will import two sets of data: Customers and Assets. 

Activity 6.1: Importing a spreadsheet to create a new FileMaker 
file

You will create a FileMaker file called Equipment Rentals.fmp12 using the spreadsheet data 
included with FileMaker Training Series: Basics. When you bring data into FileMaker Pro, tables are 
automatically created and the data is populated into fields. 

1. Click and drag the Customers.xlsx file over the FileMaker Pro application icon in your 
computer’s toolbar. 

2. In the First Row Option dialog, select Field Names and click OK. This tells FileMaker 
Pro that the first row contains column headers that should be used as field names in 
the new database. 

3. Name the file “Equipment Rentals.fmp12” and save the file on your desktop. 

4. Go to File > Manage > Database... and go to the Tables tab. The import process 
named the first table the same name as the file. Since the data in this table is customer 
data, select the Equipment Rentals table, type "Customers" in the Table Name area, 
and click Change. 

5. Click OK to exit the Manage Database dialog. 

6. Your file has been created and FileMaker Pro will show you the data on a Layout named 
Layout #2, shown in Table view. 

Note: You can also import data files from the Launch Center by choosing New… > New from 
Existing. 

�79



FileMaker Training Series: Basics for FileMaker 15

Activity 6.2: Importing a spreadsheet into an existing FileMaker 
file

Your users will also want to view Asset data in this app. Import the Assets.xlsx spreadsheet into 
the Equipment Rentals file. 

1. Choose File > Import Records > File.... Navigate to the Assets.xlsx file and click 
Open. The second set of data must be imported into a new table. 

2. Click on the drop-down labeled Target on the upper right of the Import Field 
Mapping dialog and choose New Table ("Assets"). 

3. Check the box for Don’t import first record (contains field names). Your screen 
should look like Figure 23. 

� 

FIGURE 23


4. Click Import. After the import, the Import Summary window will show that 29 records 
have been imported. Click OK. 

At this point, two tables of data exist in the Equipment Rentals file.  Both the tables and the data 
were created during the import process. 
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Lesson 6: Review Questions

1. What are the three primary methods of creating a new app? 

2. List three common file formats that can be converted directly into a FileMaker Pro file. 

3. If a file format cannot be converted directly into a FileMaker Pro file, what must you do 
to get the data into a FileMaker Pro file? 
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Lesson 6: Review Answers

1. Apps are created by beginning with a Starter Solution, importing data from another 

source, or creating an app from scratch. 

2. Three of the most common file formats converted into FileMaker files are Excel, 
comma-separated values, and tab-separated values. 

3. File formats not directly supported by FileMaker Pro must first be converted into a 
supported format. It may be necessary to request that the data be supplied in a 
supported format.  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Lesson 7: Creating Fields and 
Tables

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Create tables from the Manage Database dialog. 

• Create fields from the Field Picker in Layout mode. 

• Create fields from the Manage Database dialog. 

In this lesson, you will learn how to create fields from the Field Picker. You will also learn how to 
create tables and fields from the Manage Database dialog. FileMaker Pro gives you these 
different options to make it quick and easy to add fields while you develop your app. 

In the FileMaker Tour in FileMaker Pro, you learned how to add fields and tables to your layout. 

Basics > Layouts


• You can add fields to your layouts using the Field Picker. 

Creating Solutions > Tables


• Databases contain tables that represent categories of data, such as Assets or 
Customers. 

• Tables are made up of fields that store data in these categories. 
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LESSON 7


Section 1: Create New Tables

As you expand your app, you may discover new kinds of data that you want to include. This will 
involve adding more tables and fields. Fortunately, that’s not difficult to do. 

To review and define tables, fields, and relationships in your app, you can use the Manage 
Database dialog, shown in Figure 24. You can access it by choosing File > Manage > 
Database.... You can also use the keyboard shortcut Command-Shift-D (OS X) or Ctrl-Shift-D 
(Windows). 

� 

FIGURE 24


As you can see in Figure 24, the two sets of data that you imported into FileMaker Pro from 
spreadsheets are represented by tables. 

You can create new tables for additional data on the Tables tab simply by typing the name of the 
new table in the Table Name area and clicking on the Create button. Once the table is created, 
you can begin to add fields. 

When naming tables or fields, it is advised that you use only alphanumeric characters (or 
underscores). If you try to use other characters, you may see the dialog shown in Figure 25. 
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FIGURE 25
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Section 2: Field Types

When you define a field, you select a field type based on the kind of information the field will 
contain. The field type determines what kind of data can be entered and what kinds of operations 
FileMaker Pro can perform with the data. FileMaker Pro also uses the field type to interpret the data 
for tasks like sorting records and performing calculations. 

Field Type Data Type Notes

Text Any data that can be stored as text 
and does not need more specific 
handling. Numbers or dates can be 
stored, but in a Text field, they are 
addressed as plain text, for example in 
a text field numbers sort as 1, 10, 2, 
instead of in numerical order as 1, 2, 
10).

Can store approximately 2 
GB of Unicode values

Number Any data that need to be treated as a 
number, such as data that must be 
sorted in numerical order or used in a 
mathematical calculation. 

Text strings are displayed but ignored 
in most database operations; if you 
need to enter mixed data, use a text 
field instead.

Can store 400 digits to 
either side of the decimal 
point

Date Any date between 1/1/0001 and 
12/31/4000 (assuming m/d/y date 
formatting). 

If you enter a date in an unacceptable 
format, an error dialog results.

Dates are stored internally 
as the number of days 
elapsed from 1/1/0001

Time Either a duration or a specific time of 
day (in a 24-hour period). 

If you enter non-numeric data into a 
time field, an error dialog results.

Times are stored internally 
as the number of seconds 
from midnight
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Fields Used to Automate and Aggregate Data 
There are two field types that derive their value by referencing data in other fields: 

Timestamp A combination of date and time, 
separated by a space. 

Timestamp fields have the same date-
range restrictions as date fields.

Timestamps are stored 
internally as the number of 
seconds since midnight on 
1/1/0001

Container Any type of binary data (data that 
cannot be meaningfully represented as 
text). Can include images, signatures, 
PDFs, video or audio files, or binary 
files of any type.

Can store approximately 4 
GB of binary data

Field Type Data Type Notes

Field Type Data Type

Calculation Stores or continuously reevaluates any data based on a 
formula. 

For example, if a record has a Quantity field and a Unit Price 
field, a calculation field called Line Total can calculate the 
total by multiplying quantity by unit price.

Summary A field type that aggregates values (e.g., total for a group, 
average for a group) across a found set of records, and 
possibly for each subgroup within a sorted found set.
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Section 3: Create New Fields 
from the Field Picker

Only available in Layout mode, the Field Picker provides a useful visual display of all your existing 
fields in an inspector-like interface right next to your layout. To add fields to your layout, simply 
select, drag, and drop a field onto it in the desired location. You can also use the Field Picker to 
create new fields and drag them directly onto your layout. 

Equipment Providers, Inc. wants to provide a way for customers to sign a form verifying that their 
equipment was delivered. For the Equipment Rentals file, you will need to add a container field so 
that customers can enter their signature when they receive equipment. 

Container fields in FileMaker apps can store and enable interaction with these types of files: 

• Images 

• Video or audio files 

• Files of any type, including Word, Excel, and PDF 

Activity 7.1: Creating a New Container Field from the Field Picker

In the Equipment Rentals file, users need to gather customers’ signatures when an asset is 
delivered. Use the Field Picker to create a Signature field for the Asset table. 

1. Navigate to the Assets layout and enter Layout mode. 

2. Click the Field Picker button in the Status Toolbar to display the Field Picker, shown 
in Figure 26. 
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FIGURE 26


3. Click the icon labeled New Field. 

4. Type "Signature" as the field name, select Container as the field type. You have now 
successfully created a Container field to store Customer signatures. 

5. Drag the new Signature field out onto the layout and place it on the right side of the 
layout. 
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Lesson 7: Review Questions

1. Name four different types of fields you can create in FileMaker Pro. 

2. What types of information can be stored in Container fields? 

3. If you are editing a layout, what is the easiest way to create a new field? 

4. If you are in the Manage Database dialog, how do you create a new field? 
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Lesson 7: Review Answers

1. Text, number, date, time, timestamp, container, calculation, and summary are the field 

types you can create in FileMaker Pro. 

2. Container fields store binary data like images, signatures, PDFs, video or audio files, or 
other files. 

3. The Field Picker is the easiest way to create a new field while editing a layout. 

4. While on the Fields tab, type the name of the new field in the Field Name box, select a 
field type, and click Create. 

�92



FileMaker Training Series: Basics for FileMaker 15

Lesson 8: Relationships

�93



FileMaker Training Series: Basics for FileMaker 15

Lesson 8: Relationships

Lesson Overview 

Objectives

After this lesson, you will understand how to: 

• Distinguish between one-to-many and many-to-many relationships. 

• Use primary and foreign keys. 

• Create table occurrences. 

• Create relationships between tables. 

FileMaker is a relational database management system, which means that you can create 
relationships between tables in order to reduce redundant data entry and improve data integrity. 

The FileMaker Pro Tour in FileMaker Pro introduced the basic concept of relationships. In this 
lesson, you will learn about the different types of relationships and what is needed to create a 
relationship in FileMaker Pro. 

Here is what you learned from the FileMaker Pro Tour. 

Creating Solutions > Relationships


• Relationships connect data stored in different tables in a database. 

• You can enter data once, then view and use that data in related tables or files. 

• A portal is a layout object that displays data from related tables. 

Relationship Types 
Now that you have learned how to create tables and fields, you can link together related 
information from those different tables. A relational database reduces the need to enter the same 
data multiple times or in multiple places. 

For example, in the Equipment Rentals file, customer information is stored once in the Customer 
table. When an Asset is linked to a Customer, the user can view the related information from the 
Customer record. This saves the user from having to enter that Customer information again. Also if 
the user updates the customer’s contact information, the new information will be available for all 
Assets. 

The most common relationship types in a relational database are one-to-many and many-to-many.  
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One-to-many

This is the most common type of relationship. Consider the Equipment Rentals app: 

• Each Customer may potentially have many Assets. 

• Each Asset is associated with only one Customer. 

The relationship between Customers and Assets is a one-to-many relationship. 

When depicting the relationships between entities, there are some commonly used notations. As 
shown in Figure 27, a line is used to connect boxes representing the two entities, with a crow’s foot 
at the end that represents the "many" side of the relationship. 

� 

FIGURE 27


These relationships can be described as follows: 

• One car may have many oil changes over time; an oil change is performed on one car. 

• One customer may place many orders over time; each order is placed by a single 
customer. 

Many-to-many relationships

Now consider an app that tracks movies and actors. What is the relationship between actors and 
movies? 

• One actor may act in many movies over time. 

• One movie has roles for many actors. 

In this case, the relationship is many-to-many, as shown in Figure 28. 
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FIGURE 28


Identifying Relationship Types 
It is not always obvious whether a relationship is one-to-many or many-to-many. The correct 
answer may depend on the specifics of the situation you are trying to capture. Suppose you have 
an app that tracks paintings and artists. You may assume that the relationship between artist and 
painting is one-to-many: 

• One artist may create many paintings. 

• Each painting is created by only one artist. 

The first point seems obvious. What about the second? If the app tracks projects like community 
murals, the second point may not be correct—many artists could contribute to one painting. If you 
are tracking student paintings from a class, then you may need to think about paintings started by 
a teacher and finished by the student. The relationship may be better modeled as many-to-many. 

�96



FileMaker Training Series: Basics for FileMaker 15

LESSON 8


Section 1: Using Primary and 
Foreign Keys to Relate Tables

When relating tables, it is important to uniquely identify each record. By having a unique identifier, 
you will be able to create relationships between tables. Also, it is useful to be able to reference any 
given record by a unique identifier when troubleshooting a database. 

For example, invoices from service providers have an Invoice Number and this is often the unique 
identifier. This provides both the customer and the service provider with a way to easily reference 
the same invoice. 

Primary Keys 
A field that uniquely identifies a record in a table is called a primary key. It is recommended that you 
create a primary key in every table. A primary key should follow these rules: 

• Be unique for every record in the table 

• Never change 

• Never be empty 

It is good practice to allow FileMaker Pro to create the primary key values automatically, ensuring 
that the three rules above are followed. Note that the data you imported into the Customers and 
Assets tables already contained primary keys: Customer ID and Asset ID, respectively. The 
primary key values were manually entered in the spreadsheet, but FileMaker Pro can automatically 
assign these values for future Customers and Assets. 

Activity 8.1: Adding an Auto-Enter Field Option to Primary Keys

You will modify the existing primary key fields to auto-enter a serial number for future new records. 

1. Open the Manage Database dialog and click on the Fields tab. Make sure the 
Customers table is selected. 

2. Double click on the Customer ID field to bring up the Field Options dialog.  

3. On the Auto-Enter tab, activate the Serial number option (by entering a checkmark in 
the checkbox next to Serial number). 

4. The highest Customer ID from the imported data is 112 for Williams Design Studio. 
Change the next value to 113, as shown in Figure 29 to make sure the values in this 
field are always unique. 
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5. Activate Prohibit modification of value during data entry (at the very bottom) to 
prevent users from modifying the primary key. Click OK. 

� 

FIGURE 29


6. Change the list of fields to the Assets table.  

7. Double click on the Asset ID field. Repeat step 3, 4, and 5 above, but change the next 
value to 1984. 

Foreign Keys 
While a primary key is an attribute that allows you to uniquely identify a Customer, how can it be 
used to link a Customer to one or more Assets? For the relationship to be established, a field must 
be created in the Asset table. You can assign a Customer to an Asset by entering the Customer's 
primary key value into an Asset record, thereby providing a link between the two tables. The term 
for this type of field is a foreign key. 

When thinking about a one-to-many relationship, the "many" side will always contain the foreign 
key. In the Equipment Rentals file, the Asset table requires a customer foreign key. 

The foreign key, Customer ID, has already been created in the Asset table. 

�98



FileMaker Training Series: Basics for FileMaker 15

LESSON 8


Section 2: Creating 
Relationships

The Relationships tab of the Manage Database dialog contains the Relationships Graph. It 
provides a way to graphically represent and specify relationships among the tables in your 
database. 

Each box on the graph is called a table occurrence (TO). Think of a TO as an alias or shortcut to a 
table. To check the source table for a TO, hover your mouse over the small arrow left of the name 
of the TO, as shown in Figure 30. Because you can create multiple TOs based on the same table, 
you can create many different relationships between any two tables. 

� 

FIGURE 30


Creating Relationships 
With primary keys and foreign keys created in the Equipment Rentals file, the database is properly 
setup to create relationships between tables. 

Activity 8.2: Creating a Relationship

You will set up a relationship between the Customers and Assets tables.  

1. Navigate to the Relationships tab of the Manage Database dialog.  

2. Click and drag from the Customer ID field in Customers to the Customer ID field in 
Assets. Your relationships graph will look like Figure 31. 
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FIGURE 31


3. Click OK to close the Manage Database dialog. 

A relationship has now been created between the primary key in the Customers table and the 
corresponding foreign key in the Assets table. This will allow you to associate any number of 
Assets with a given Customer. 
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Lesson 8: Review Questions

1. What are the two most common types of relationships? 

2. What is the type of relationship between the following: 

๏ Actors and Movies 

๏ Songs and Concerts 

๏ Aircrafts and Inspections 

๏ Race and Swimmer 

3. What field should you create in every table of your FileMaker app? 
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Lesson 8: Review Answers

1. One-to-many and many-to-many are the most common relationships. 

2. The relationships are: 

๏ Many-to-many 

๏ Many-to-many 

๏ One-to-many 

๏ Many-to-many 

3. You should always add a primary key field to every table. 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Lesson 9: Layouts

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Create layouts for specific devices. 

• Add fields to layouts. 

• Apply styles and themes to layouts. 

Layouts provide the canvas for creating your user interface. Whether you will present forms, lists, 
reports, charts, or complex workflows, layouts are the way to present information and actions for 
your users.  

A layout consists of: 

• A layout area  

• Objects such as fields, web viewers, tab controls, etc. 

• A single theme and various styles 

Here is what you learned from the FileMaker Pro Tour.  

Creating Solutions > Themes & Styles


• Themes provide coordinated colors, fonts, and other styling for layouts. 

• Some themes are specially designed for iOS devices. 
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Section 1: Creating Layouts

A layout organizes how you see information in a FileMaker app. Whether you are entering data or 
printing reports, the layout handles how the data is displayed. Layouts do not store data. You can 
create many layouts to see the same record—or set of records—in different ways. 

Each layout is tied to a table occurrence, which is considered the layout’s “context.” Each layout is 
associated with one table occurrence on the Relationships Graph. 

In order to create, view, and modify layouts, you need to be in Layout mode. In addition to the 
standard ways of switching modes—the View menu and the pop-up menu in the bottom left of the 
document window—FileMaker also has an Edit Layout button at the bottom right of the Status 
Toolbar when viewing a layout in Form or List view, shown in Figure 32. 

FIGURE 32


Activity 9.1: Creating a New Layout

You will create a layout in Equipment Rentals.fmp12 that displays data from the Customers table 
for use with FileMaker Pro on a desktop or laptop computer. 

1. Choose View > Layout Mode, or use the keyboard shortcut Command-L (OS X) or 
Ctrl-L (Windows) to enter Layout mode. 

2. Choose Layouts > New Layout/Report, or click the New Layout/Report button in 
the Status Toolbar, or use the keyboard shortcut Command-N (OS X) or Ctrl-N 
(Windows). 

3. Choose the Customers table occurrence on the Show records from: drop-down list. 

4. Change the layout name to "Customer Details". 

5. Click on Computer since the new layout will be viewed using FileMaker Pro on a 
desktop computer. 

6. Choose Form so that the layout will show one record at a time, as shown in Figure 33. 
Click Finish. 
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FIGURE 33


Layout Parts 
FileMaker layouts are divided into layout parts. The three most used parts are the header, body, 
and footer. These different sections of the layout control how and where data, text, and graphics 
are displayed. For example, text placed in a header part prints at the top of each page, while text 
placed in the body part appears once for each record. 

When you create a new layout, it automatically has one or more parts depending on the choices 
you made in the New Layout/Report dialog. Each layout must have at least one part. In Layout 
mode, a gray horizontal line marks the division between layout parts. You can resize a part by 
dragging the line up or down. You will learn more about Layout Parts in Lesson 16: Reporting. 
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LESSON 9


Section 2: Adding Fields to a 
Layout

When you create a new layout by clicking on New Layout/Report, the layout will not have any 
fields, which means no data will be visible. Depending on the needs of your users and how they 
plan on using the layout, it may contain as few or as many fields as is necessary. 

Activity 9.2: Adding Fields to a Layout Using the Field Picker

Equipment Providers, Inc. needs a layout that will include all of the customer information. You will 
use the Field Picker to add fields to the Customer Details layout. 

1. Click the Field Picker button in the Status Toolbar, or use the keyboard shortcut 
Command-K (OS X) or Ctrl-K (Windows). The Field Picker will appear, shown in 
Figure 34. 
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FIGURE 34
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2. Click on the Customer ID field. Hold down the Shift key and click on the last field, 
Tier. All fields will now be highlighted. 

3. Drag the selected fields to the layout. This will add the fields along with a field label, 
based on the field name, as shown in Figure 35. 
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FIGURE 35


4. Enter Browse mode (save your changes to the layout, if prompted), and flip through a 
few records. 

Selecting Fields from Field Picker 
If you want to select multiple fields that are grouped together in the Field Picker: 

• Click on the first field 

• Hold down the Shift key 

• Click on the last field 

If you want to select multiple fields that are not grouped together: 

• Hold down the Command (OS X) or Control (Windows) key 

• Click on each field 
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LESSON 9


Section 3: Layout Themes and 
Styles

Themes 
Themes help create a visually attractive user interface by providing consistent styles for buttons, 
fields, background, and other objects on a layout. Themes apply predefined fonts, sizes, colors, 
padding, and other styling to your layout objects. 

When you select a new theme for a layout, all existing layout objects adopt the new theme’s styles. 
Object positions, however, remain fixed, so it may be necessary to adjust some of the objects 
manually depending on the theme selected. It is recommended that you experiment with several 
themes before you choose one. 

Note: A theme called Enlightened is the default theme for any new file you create or a file that has 
been created from an Excel spreadsheet. 

Activity 9.3: Changing the Theme

You will choose a theme that will be used throughout all the layouts for the Equipment Rentals file. 

1. From the Customer Details layout, enter Layout mode. 

2. Choose Layouts > Change Theme... or use the Change Theme �  button in the 
layout bar. A popup will appear showing you all the themes available, shown in Figure 
36. 
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FIGURE 36


3. Select the Vibrant theme and click OK. 

The formatting of all objects on the layout will change to match the defaults of the Vibrant theme.  

FileMaker also contains a set of themes with the suffix “Touch.” These themes are specifically 
designed for layouts built for iOS devices. Each of these themes use recommendations from 
Apple’s iOS Human Interface Guidelines by making fonts larger and buttons bigger for easier use 
on iOS devices. When developing an app for iOS, it is recommended that you use a Touch theme. 

Styles 
Each theme comes with a set of styles for each object type. Styles allow you to easily define 
consistent and reusable formatting, applying it to objects on a single layout or across all layouts. All 
formatting options found in the Inspector can be used when defining a style. You can even use an 
image for the background of an object and save that as part of the style. 

Styles are part of the overall layout theme. Within a theme, each type of layout object may have 
many available styles. For example, a button object may have default, accent, and navigation styles 
among others. Each object on a layout has a style assigned to it. Upon assigning a style to an 
object, it is formatted according to the style. 

You can edit existing styles as well as create new styles. Changes to existing styles can be applied 
to all objects with that style on the current layout or to all objects with that style on every layout that 
uses the same layout theme. 

Utilizing consistent themes and styles throughout your app can make updating the look and feel of 
your app quick and easy. You can access styles by going to the Styles tab on the Inspector while 
in Layout mode, as shown in Figure 37. 
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FIGURE 37
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LESSON 9


Section 4: Creating More 
Layouts

It is common to have different views of the same data. For example, while the Customer Detail is 
helpful in the Equipment Rentals file, the app can benefit from a Customer List as well. With the 
Customer List (List view), a user can scroll and see essential data about multiple Customers at 
once. With Customer Details (Form view), the user can see each customer's full details one at a 
time. 

Activity 9.4: Creating a List View Layout

1. Enter Layout mode and create a new layout. 

2. Show records from the Customers table and name the layout “Customer List”. 

3. Select Computer and List, then click Finish. 

4. Open the Field Picker and change the Drag Options to place fields horizontally with 
labels above the field like Figure 38. 
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FIGURE 38


5. Add the following fields to the layout with the Field Picker: 

๏ Customer ID 

๏ Company 

๏ State 

๏ Tier 

You can select multiple fields by holding Command (OS X) or Control (Windows) while 
clicking. Place the objects on the layout so that the labels are in the Header and the 
fields are in the Body. 
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6. If necessary, select the labels and change their font color to white by clicking on View > 

Formatting Bar or by clicking the #  button in the layout bar. (You may need to 
change the format and space out the fields and labels to avoid overlapping. Select and 
move the objects around so that your layout, in Browse mode, looks like Figure 39. For 
more details on moving objects, see Lesson 10.) 

� 

FIGURE 39


With the two Customer layouts you created, Customer List and Customer Detail, users will be 
able to see a little bit of data about multiple customers or a lot of data about one specific customer. 

In addition to these, users will want a list of Assets in your app. Let’s add that now. 

Activity 9.5: Creating an Asset List

Similar to Activity 9.4, you will create a List view layout. In this activity, the layout will show a list of 
Assets. 

1. Enter Layout mode and create a new layout. 

2. Show records from the Assets table and name the layout “Asset List”. 

3. Select Computer and List, then click Finish. 

4. Add the following fields to the layout with the Field Picker: 

๏ Asset ID 

๏ Customer ID 

๏ Item 
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๏ Model 

๏ Category 

5. As in Activity 9.4, you may need to space out the objects on the layout to keep their 
labels from overlapping. Enter Browse mode. Your layout should look similar to Figure 
40. 

� 

FIGURE 40
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Lesson 9: Review Questions

1. In which mode can you create layouts? 

2. What are the device options when creating a new layout? 

3. What tool allows you to quickly add multiple fields to a layout? 

4. Which themes are better suited for iOS devices? 
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Lesson 9: Review Answers

1. All layouts are created in Layout Mode. 

2. Computer, touch device, and printer. 

3. The Field Picker. 

4. Any theme with the suffix “Touch”. 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Lesson 10: Layout Design Tools
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Lesson 10: Layout Design Tools

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Style objects with the Inspector. 

• Select, move, and resize objects. 

• Turn on Grids and Guides. 

• Create layouts built and sized for iOS devices. 

Once layouts are created, the next step is to place objects on the layout and style them 
appropriately. It is important to make interfaces that are consistent and easy for users to 
understand. Small inconsistencies within or between your layouts distract your users, causing them 
to assess whether the difference they are observing has a meaning in the interface or is just 
accidental. Grids, Guides, and Stencils are some of the tools available in FileMaker Pro to aid 
developers in creating the best experience possible for their users. 

Here is what you learned from the FileMaker Pro Tour. 

Creating Solutions > Layout Objects


• Layout objects are elements placed on a layout. They enable users to view and interact 
with data. 

• You can select, move, resize, delete, copy, format, name, and change objects. 

Creating Solutions > Layouts


• FileMaker Pro includes tools to create beautiful layouts for easy data entry and analysis 

• You can customize layouts by editing objects, positioning and arranging them, resizing 
them, and making other changes to their appearance. 
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LESSON 10


FIGURE 42
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Section 1: Status Toolbar and 
Inspector

In Layout mode, the Status Toolbar provides quick and easy access to many of the tools used for 
building layouts. These tools, shown in Figure 41, allow you to create new layout objects and apply 
colors and styles to existing objects. 
 

FIGURE 41


The bottom row of the Status Toolbar is called the Formatting Bar. If it is not displayed, you can 
activate it by clicking on View > Formatting Bar or by clicking the #  button in the layout bar. 

The toolbar includes standard text and drawing tools similar to those in other applications. For 
example, to add a box to a layout, click the Rectangle tool, then click and drag to draw the box 
on the layout. 

Inspector 
The Inspector is the object control center where you can view and modify the settings for all 
objects on a layout. Each of the four panes of the Inspector—Position, Styles, Appearance, and 
Data—focuses on a different aspect of formatting (Figure 42). 
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You can open an Inspector by using any of these methods: 

• Choose View > Inspector (or View > New Inspector for multiple Inspectors). 

• Click the #  button in the layout bar. 

• Use the keyboard shortcut Command-I (OS X) or Ctrl-I (Windows). 

You can quickly switch to an Inspector tab by using the keyboard shortcuts Command-1, 2, 3, 
and 4 (Mac OS) or Ctrl-1, 2, 3, and 4 (Windows). 
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Section 2: Layout Resizing

A number of tools help you manage the size of your layouts and the objects they contain. This 
becomes useful when duplicating a layout meant for one device and modifying it to suit another, 
such as taking an iPad layout and expanding it for the desktop. 

Layout Width 
To set the width of a layout, drag the dark gray line that represents the right edge of the visible 
layout area. This defines the area where objects will be seen in Browse mode. Any object placed 
outside of the layout’s defined width is treated as an invisible object in Browse mode. 

Screen Stencils 
When you are creating apps for different platforms and screen sizes, FileMaker Pro contains a set 
of screen stencils that you can use for accurate layout sizing. You can easily optimize layouts for 
iOS devices by using a stencil. 

Each stencil shows the borders of the specific iPad or iPhone form factor in both portrait and 
landscape orientation to aid in design. The stencils can be turned on or off in the formatting bar. 
You can turn on multiple stencils at the same time for cross-platform apps or for multi-orientation 
devices such as iPhone and iPad. Figure 43 shows a layout with one iPhone stencil turned on. 
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FIGURE 43


To toggle the screen stencils, click the stencil icon on the right side of the Status Toolbar, shown in 
Figure 44. Clicking the arrow will provide you with a list of stencils that can be turned on or off, 
including different desktop resolutions, iPhone, iPad, and a custom size. 




FIGURE 44


Selecting, Resizing, and Moving Objects 
To select a layout object, click on the object (for example, any field in the Equipment Rental file is 
considered an object). You will see small squares, called handles, that represent the corners and 
sides of the object. 
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You can change the size of an object by dragging any of the handles. If multiple objects are 
selected while dragging the handles, the objects will all resize with respect to each other. This is 
very useful, especially when resizing a group of fields and other layout objects. 

You can move an object that you have selected by dragging any part of the object other than its 
handles. To move an object a small distance, select it, then use the arrow keys on the keyboard to 
move an object one point (pt) at a time. 
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Section 3: Guides and Grids

Dynamic Guides 
Guides help you align objects on a layout during your app creation process. The two types of 
guides are dynamic guides and ruler guides. 

Dynamic guides enable you to define the position and size of objects based on other objects on 
your layout. As you move or resize an object, blue lines appear to indicate that the object you are 
changing is aligned to other objects. 

Figure 45 shows the dynamic guides that appear as you move or resize an object on a layout. 

FIGURE 45


Ruler Guides 
In order to position objects on your layout more precisely, turn on the page rulers (choose View > 
Rulers). To create a ruler guide, click either the top ruler for a horizontal guide or the left ruler for a 
vertical guide, and drag the guide onto the layout. Figure 46 shows a layout with two horizontal 
guides and three vertical guides. 
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FIGURE 46


The Snap to Guide feature automatically aligns objects to the nearest guide when you move 
objects within a few points of the guide (activate by choosing View > Guides > Snap to Guide.) 

Object Grid 
In order to display a grid on your layout, turn on the Object Grid, which will show major and minor 
grid lines. Enable the Object Grid using either of these methods: 

• Choose the View > Grid > Show Grid. 

• Find it at the bottom of the Position pane on the Inspector. 

When you check Snap to grid, moving or resizing objects on your layout will cause them to snap 
to the major and minor grid lines. You can change the increments at the bottom of the Position 
pane on the Inspector. 
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Section 4: Using Layout Design 
Tools

Suppose that during the Equipment Providers, Inc. discovery phase, you learned that Assets may 
be given to a Customer during an on-site visit, and the user needs to collect a signature confirming 
that the Asset was received. Since FileMaker Go serves as a great tool for mobility and capturing 
signatures, you will need to create an Asset layout for iPhone and iPad. 

Activity 10.1: Creating an iPad Layout

You will create a Form view layout that is appropriately sized for the iPad.  

1. Click on New Layout/Report. 

2. Base the layout on the Assets table occurrence and name it "Asset Details - iPad".  

3. Choose Touch Device. Then choose iPad. 

4. Choose Form. Click Finish. 

5. Change the theme to Vibrant Touch.  

6. Turn on the iPad (portrait) screen stencil. 

7. Set the Drag Options to vertical fields in the Field Picker with the labels on the left. 

8. Add the following fields to the layout with the Field Picker, within the stencil. In 
Browse Mode, your layout should look like Figure 47: 

๏ Asset ID 

๏ Customer ID 

๏ Item 

๏ Model 

๏ Serial Number 

๏ In Service Date 

๏ Purchase Date 

๏ Cost 

๏ Signature 
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FIGURE 47


Activity 10.2: Creating an iPhone Layout

You will create a version of the Asset Detail layout that will be sized for an iPhone screen. 

1. Create a Form view layout based on the Asset table called "Asset Details - iPhone". 
Choose Touch Device. Then choose iPhone. Choose Form and then click Finish. 

2. Change the theme to Vibrant Touch. 

3. Turn off the iPad screen stencils and turn on the iPhone (portrait) screen stencil. 

4. In the Field Picker, set the Drag Options to vertically align fields with the label on top 
like Figure 48. 

� 

FIGURE 48


5. With less screen space on iPhone, you may not want to include all the fields from the 
iPad layout. Add the following fields to the layout with the Field Picker: 
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๏ Item 

๏ Serial Number 

๏ Signature 

6. If necessary, extend the layout's height by dragging down the bottom edge of the 
Body. In Browse mode, your layout should look like Figure 49. 

� 

FIGURE 49
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Lesson 10: Review Questions

1. What is the name of the object control center where you can view and modify the 

settings for any object? 

2. What do Screen Stencils show? 

3. What is the difference between Dynamic Guides and Ruler Guides? 
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Lesson 10: Review Answers

1. The Inspector is the object control center where you can view and modify the settings 

for any object. 

2. Screen stencils show the borders of a chosen device for the size specified. 

3. Dynamic guides automatically display blue lines that help you align and size objects in 
relation to other objects on the layout. When designing a layout, you have control in 
setting ruler guides where you need them to align objects consistently on one or many 
layouts. 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Lesson 11: Special Layout 
Objects
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Lesson 11: Special Layout Objects

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to create the following layout objects: 

• Portal 

• Tab Control 

• Panel Control 

• Popover 

• Web Viewer 
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From the Status Toolbar, you can add basic items such as text, shapes, fields, and a variety of 
special layout objects, as shown in Figure 50. These objects perform specific and special functions 
on a layout that you will learn about in this lesson. 

� 

FIGURE 50
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LESSON 11


Section 1: Portal

A portal is a tool for displaying a set of related records. In a one-to-many relationship, a portal 
shows the "many" side of a relationship.  

In Activity 8.2, you created a relationship from Assets to Customers, where the Asset's Customer 
ID field matches the Customer's Customer ID field. 

Activity 11.1: Viewing Related Data via a Portal

You will create a portal on the Customer Details layout that will show related Assets. 

1. Navigate to the Customer Details layout and enter Layout mode. Turn off any screen 
stencils used in previous activities. 

2. Portals are created by either clicking on the Portal tool#  in the Status Toolbar or 
using the Insert > Portal menu item. For this step, choose Insert > Portal. 

3. In the Portal Setup window, click on the Show related records from: drop-down 
and choose Assets as the related table (Figure 51). 

�135

riazahmedsqa
Highlight

riazahmedsqa
Highlight



FileMaker Training Series: Basics for FileMaker 15

� 

FIGURE 51


4. Activate Allow vertical scrolling to enable the user to scroll down if the list of related 
data extends beyond the viewable area. Click OK. 

5. A window titled Add Fields to Portal will appear. Double-click on the following fields 
and click OK: 

๏ Category 

๏ Item 

๏ Serial Number 

๏ Purchase Date 

๏ Cost 

6. A portal with related fields in its first row will appear on your layout. Move the portal to 
the right side of the screen. 

7. Adjust the width of the portal and the related fields by making them bigger. 

8. Unlike adding fields using the Field Picker, the Portal tool does not automatically 
create related field labels. Use the Text icon in the toolbar to manually add labels for 
each field. 

9. Go to Browse mode and your portal on the layout should look similar to Figure 52. 
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FIGURE 52


Adding Related Fields to a Layout

Earlier you created a relationship from Assets to Customers, where the Asset's Customer ID field 
(a foreign key) matches the Customer's Customer ID field (a primary key). In order to show data 
from a related record, you can change the Current Table drop-down in the Field Picker to the 
correct related table and add fields to the layout. 

Activity 11.2: Adding Related Fields

You will add the Company field to the Asset Details - iPad layout from the related Customers 
table. 

1. Navigate to the Asset Details - iPad layout. 

2. Enter Layout mode. 

3. Using the Field Picker, change the Current Table drop-down in the Field Picker to 
the related table Customers, and change the Drag Options to not include a label. 

4. Drag the Company field onto the layout next to Customer ID so it looks like Figure 53. 

5. Enter Browse mode and navigate between records to view the company name for 
each asset. 
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FIGURE 53
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Section 2: Tab Control

A user interface that includes tabs is a popular design feature for many applications. When you 
select a tab, it displays a unique set of objects or data, which allows you to use the same section 
of layout real estate for multiple purposes. 

The term tab control refers to the entire layout object, as shown in Figure 54. Each tab control 
contains one or more individual tab panels identified by a series of tabs running across the top of 
the object. Note that the tab control is not a navigation tool; rather, it is a layout organization tool 
used to selectively display different sets of fields (or related fields) from the same layout context. 

� 

FIGURE 54


Tab controls are placed on the layout using the Tab Control tool#  in the Status Toolbar. You 
can modify the appearance of a tab control object in several ways. You can add, rename, remove, 
or reorder the panels in a tab control through the Tab Control Setup dialog (shown in Figure 55). 
Access the Tab Control Setup dialog by double-clicking or right-clicking the tab object. The 
Tab Control Setup dialog also provides a way to define the default front tab, the tab justification, 
and tab width. 
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FIGURE 55


With the help of the Inspector, you can customize many other aspects of your tab control. Using 
the Appearance tab of the Inspector, you can specify the background fill, borders, and corner 
radius, as well as tab-specific attributes for the hover state. However, all tabs must have the same 
text style attributes, such as font, color, and size. 

To place an object on a tab panel: 

1. Enter Layout mode. 

2. Select the tab panel. 

3. Move the object so that it is entirely contained within the boundaries of the selected tab 
control. 

If you need to move a tab control, simply drag the tab control object itself. All objects contained 
within all tabs will move. 
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Section 3: Slide Control

The slide control is inspired by the page control of the iOS interface. The springboard (or home 
screen) on iPad, iPhone, and iPod touch is an example of an iOS page control. 

Similar to the tab control, the term slide control refers to the entire layout object as shown in Figure 
56. 

� 

FIGURE 56


Each slide control can contain one or more slide panels. Because the two controls are related, the 
tab control and slide control are created using a single tool on the status toolbar.  

To add a slide control to a layout: 

1. Click and hold the Tab Control # or Slide Control �  tool and select Slide 
Control. 

2. Click and drag on the layout to draw the boundaries of the new slide control. 

After drawing the boundaries of the slide control, the Slide Control Setup dialog, shown in Figure 
57, will appear. It can also be opened by double clicking the slide control object. The Slide 
Control Setup dialog includes settings for:  

• Specifying the number of panels 

• Whether or not FileMaker Go or touch-enabled FileMaker Pro users can swipe to 
navigate between panels  

• Whether or not navigation dots are displayed  

• Specifying the size of the navigation dots 
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Note that when the dots are not displayed, the developer must provide buttons or some other 
scripted way to navigate between slide panels. 

� 

FIGURE 57
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Section 4: Popover

When you click a popover button, it expands to display a popover object that floats over the 
window, obscuring the content behind it. Figure 58 shows a popover button that has been clicked 
to reveal the popover object. The popover object is a panel in which you can display any type of 
layout object. Similar to a tab control or slide control, it has the same context as the layout. 

� 

FIGURE 58


Like the tab control and slide control, popovers can be used to hide portions of a complex layout, 
only revealing the information when it is needed. They also simplify the user experience by 
providing an alternative to switching to another layout or opening a new window Here are some of 
the ways you could use them: 

• Detailed information about an object or data 

• A portal containing a related set of data 

• A web viewer used to render a map, dashboard, or aggregate information 

• Help text to give the user instructions 

• A navigation bar or navigation sub-menu 

Similar to tab controls and slide controls, a single tool on the Status Toolbar is used for creating 
buttons and popover buttons.  

To add a popover button to a layout: 
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1. Click and hold the Button # or Popover Button # tool and select Popover 
Button. 

2. Click and drag on the layout to draw the boundaries of the popover button. 

When a popover button is created, its associated popover object is automatically created, and the 
Popover Button Setup dialog (Figure 59) is displayed. This dialog provides options for specifying 
the popover button’s text and icon placement, the text to display on the button, the popover 
object’s title, the location of the popover object relative to the button, and script triggers. 

� 

FIGURE 59


Once the Popover Button Setup dialog is closed, it can be displayed again by double-clicking 
the popover object or by right-clicking the popover object and selecting Popover Button 
Setup. 
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Section 5: Web Viewer

A web viewer is an object used to display web pages directly in a FileMaker layout. Web viewers 
have many practical uses in FileMaker apps. For example, a web viewer can: 

• Display a map website that contains directions to the address stored in a company 
record 

• Calculate the URL for tracking a package based on data stored in a tracking number 
field 

• Display search engine results for data from a product name field 

• Look up stock quotes for company records 

• Display reports and graphs using financial data from your FileMaker app 

The Web Viewer Setup dialog allows you to construct the URL that the web viewer uses to 
display a web page. The URL usually includes fields in the calculation, meaning that data from the 
current record can be used to dynamically search the web. 

Note: The user’s device or computer must be connected to the Internet in order for a web viewer 
to display an external web page. 

Activity 11.3: Adding a Web Viewer

In this example, you will add a web viewer to the Customer Details layout and configure it to 
display Google Maps search results for the customer’s address. Please note that you will need to 
be connected to the internet in order for the web viewer in this example to connect to Google 
Maps. 

1. Go to the Customer Details layout and go into Layout mode. 

2. Select the Web Viewer tool (# icon) in the Status Toolbar. Define the area on the 
layout by drawing a box for the boundaries of the new web viewer. The Web Viewer 
Setup dialog will appear. 

3. Choose Google Maps (US) in the Choose a Website box on the left hand side. 

4. Click on the #  button next to the Address box and select Specify Field Name... 

5. Choose the Address field from the Customers table and click OK. 

6. Repeat steps 4 and 5 for the City, State, and Zip Code boxes, selecting the City, 
State, and Zip fields from the Customers table accordingly. The Web Viewer Setup 
dialog should look like Figure 60 when you are done. 
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FIGURE 60


7. Click OK on the Web Viewer Setup dialog, save the layout, and go into Browse 
mode. Your layout should look similar to Figure 61. 
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FIGURE 61


Navigate through Customer records to test the web viewer. It should display Google Maps search 
results for the address of the current Customer record. 

Note: You may need to make the web viewer larger (and possibly the layout as well) in order to 
view the contents of the Google Maps page. 
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Lesson 11: Review Questions

1. What are five special layout objects? 

2. A portal is used to view which side of a one-to-many relationship? 

3. How do you add an object to a tab control? 

4. What are some uses for popover buttons? 

5. How can web viewers be dynamic? 
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Lesson 11: Review Answers

1. Portals, tab controls, slide panels, popovers, and web viewers are five special layout 

objects. 

2. Portals are used to view the “many” side of a relationship. 

3. To add an object to a tab control, select the tab panel you would like the object to 
reside on, then drag the object onto the panel until it is completely surrounded by the 
tab control. 

4. Popovers can be used for situations where you might have needed another window to 
display things like detailed information about other data, a map, help text, or a 
navigation bar.  

5. Web viewers can go to websites based on field data, allowing them to dynamically 
search the web. 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Lesson 12: Formatting Field 
Objects
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Lesson 12: Formatting Field 
Objects

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Format a date, number, or time field object. 

• Apply conditional formatting to a field. 

• Change the control styles for a field. 

• Create a static value list. 

Users spend much of their time viewing and editing data in an app. FileMaker’s many options for 
formatting data allow you to create a more consistent user experience. You can also help speed up 
the data entry process by providing users with pop-up menus, drop-down calendars, and more.  

In this lesson, you will learn about the different ways to format dates, times, and numbers, the 
options for formatting objects based on certain conditions, and controls for data entry. 
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LESSON 12


Section 1: Data Formatting

In addition to specifying attributes of your data including font and color, FileMaker Pro allows you to 
display numbers and dates with special formatting—such as currency, a percent, a specific date 
format, and so on. The Inspector helps you apply these types of formatting at the object level. 

By default, the formatting for a date field will be As Entered. If a user types 6/7/2015 or 6.7.2015, 
the user would see the values exactly as the user entered it. On a list view layout, inconsistency in 
formatting can make it harder to scan and interpret the data quickly. 

With Data Formatting, you have the flexibility to format that data in numerous ways for consistency 
while allowing users to enter data in any format they wish. 

Activity 12.1: Applying Formatting to Fields

You will change the formatting on the date fields so they will show consistently, regardless of how 
the user entered the data. 

1. Navigate to the Asset Details - iPad layout. 

2. Enter Layout mode and open the Inspector. 

3. Select the In Service Date and Purchase Date fields by holding down the Shift key 
and clicking on both fields. 

4. In the Inspector, choose the Data tab. The last section is titled Data Formatting. 

5. Click on the Format drop-down to see all the date formatting options.  

6. Choose the format that shows the date in MM/DD/YY (12/25/14) format. In the 
example above, regardless of how the user enters the date, it will now display on this 
layout as 6/7/15. 

7. Change the data formatting for the Cost field by choosing Currency and setting the 
Fixed number of decimals: to 2. 

8. Increase the width of the Cost field so that you will be able to see the result (Figure 62). 
Return to Browse mode. 
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FIGURE 62


Formatting fields is a common practice in order to keep your data looking consistent. Often, 
numbers are shown as currency for a price field and as a percentage for a margin field. Time fields 
can be set to 12 or 24 hour formatting. For Container fields, you can specify whether the original 
proportions will be maintained, as well as if the user will be able to interact with certain file types 
like PDFs and videos. 
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LESSON 12


Section 2: Conditional 
Formatting

Conditional formatting allows you to change the look of an object based on specified rules. By 
doing so, you can draw a user's attention to data that might be missing, incorrect, or outside of 
certain boundaries. For example, you can specify that a field have a red background color when it 
is empty and white when the field contains a value. A price field might display bold and red if its 
value is greater than $5,000. 

Activity 12.2: Using Conditional Formatting

You will apply conditional formatting to the Cost field. If the cost is more than $1,000, the cost will 
appear in blue. 

1. On the Asset Details - iPad layout, in Layout mode, select the Cost field. 

2. Choose Format > Conditional.... A window will appear, allowing you to set the criteria 
that will activate the conditional formatting. 

3. Click Add. 

4. In the Condition section, change between to greater than, then type "1000". 

5. In the Format section, activate Text Color and choose a bright blue, as shown in 
Figure 63 and click OK. 
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FIGURE 63


6. Enter Browse mode and look at different records. Notice that any value over 1000 (but 
not equal to 1000) shows as blue text. 
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Section 3: Field Control Styles

Whenever people manually type in data, misspelling and inconsistencies occur. Field control styles 
are used to format how users interact with fields. The two primary benefits of field control styles 
are: 

• Users can enter data faster. 

• Your data will be more accurate and consistent. 

To set the control style for a specific field, open the Inspector and use the Field section of the 
Data tab. 

There are seven different control styles. They are: 

• Edit Box: This is a standard field for free-form data entry. An Edit Box can include a 
vertical scroll bar and offers the option to auto-complete data from previously entered 
values. 

• Drop-down List: You can use this style to enable users to choose an item from a 
value list or to manually enter a value. Use this option when there are a large number of 
values to choose from. 

• Pop-up Menu: To use this style, you must click on the menu to activate it, then see 
your available choices. This style is good when there are only a few items in the list 
because the pop-up menu grows to show all the possible choices. 

• Checkbox Set: This style presents the value list as a set of checkboxes which users 
can select and deselect. More than one checkbox can be selected. 

• Radio Button Set: Radio buttons are similar to checkboxes except that clicking one 
radio button causes a different radio button to be deselected, so that only one value is 
selected at a time. This style is appropriate for lists with exclusive choices such as yes 
or no. 

• Drop-down Calendar: This control style allows users to select a small drop-down 
calendar to enter a date into a field. 

• Concealed Edit Box:  This control style allows you to hide confidential information by 
setting a field to display bullets in place of data. 
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LESSON 12


Section 4: Value Lists

Value lists in FileMaker Pro help facilitate rapid data entry and minimize the possibility of data 
errors, misspellings, or inconsistency. Instead of requiring a user to type something like a project 
status, you can set up a value list so the user can choose Active, Inactive, or Pending from a drop-
down list or a radio button set. 

A value list can be made of static values, like the project status example above, or it can be a 
dynamic list, which means that the values are based on a field in your FileMaker app. This type of 
dynamic list is used frequently for selecting the value for a foreign key field. 

In the Equipment Rentals file, the Category field in the Assets table is a great candidate for a drop-
down list, which will help standardize the values entered into the field. The Equipment Rental 
discovery phase identified issues with incorrect and misspelled values in the data. By setting the 
field with a drop-down list, there is less chance for error in data entry. 

Activity 12.3: Using Field Controls and Value Lists

1. On the Asset Details - iPad layout, enter Layout mode. 

2. Add the Category field to the layout, below Customer ID and above Item. 

3. Click on the Category field. In the Inspector, choose the Data tab. In the Field 
section, click on the Control Style list and choose Drop-down list. 

4. Click on the pencil icon next to Values from:. This will bring up the Manage Value 
List dialog. Click New. 

5. Name the value list Categories. 

6. Type the following into the custom values, as shown in Figure 64: 

Appliances 
Cameras 
Computers 
Office Furniture 
Telephones 
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FIGURE 64


7. Click OK to close the Edit Value List dialog. Click OK again to close the Manage 
Value Lists dialog. 

8. Switch to Browse mode and click in the Category field. From now on, when a user 
clicks in the Category field, the list of values will appear. 

Similar to conditional formatting, field control styles are applied per object. If you want to add a 
drop-down list to any instance of the Asset's Category field on a layout, you will need to edit each 
instance. 
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Lesson 12: Review Questions

1. What is the main goal of data formatting? 

2. How can conditional formatting help users? 

3. How can field control styles improve data consistency? 

4. What are the two types of value lists? 
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Lesson 12: Review Answers

1. The goal of data formatting is to make data look consistent and not dependent on user 

entry. 

2. Conditional formatting changes the appearance of layout objects based on logical 
conditions. Generally, it is used to draw users’ attention to important data. 

3. Field control styles improves data consistency by allowing users to select from a set of 
values instead of typing free form. 

4. The two types of value lists are static (using custom values) and dynamic (using values 
from a field). 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Lesson 13: User Interface Best 
Practices

Lesson Overview 

Time

This lesson takes approximately 5 minutes to complete. 

Objectives

After this lesson, you will be able to create layouts that: 

• Have a purpose. 

• Are optimized for touch devices. 

• Offer a pleasing, consistent experience. 

The last four lessons demonstrated many of the tools for building interfaces in FileMaker. With all of 
the options at your disposal, it is helpful to have some guidelines for building the best possible app 
for your users.  

This lesson will provide you with a list of best practices for building interfaces in FileMaker, including 
guidelines for the support of multiple devices, the usage of color and styles, and the need for a 
consistent and predictable interface. 
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Section 1: User Interface Best 
Practices

Here are some guidelines for you to follow when building your apps. 

• Build layouts for each device type - For the best user experience, you will want to 
design specific layouts for each device. For example, use one layout for iPhone, a 
different one for iPad, and yet another for a laptop or a large desktop display. Building 
separate layouts for each device ensures that your app delivers the best possible 
experience based on each device’s unique properties. 

• Purpose - The purpose of each screen should be clear and easy to understand. Users 
should be able to figure it out quickly and take appropriate action. 

• Hierarchy - Each screen should have a clear, well-defined hierarchy of information. 
This helps users zero in on the information they need the most. 

• Touch - When building for iOS devices, buttons should be a minimum of 44pt x 44pt to 
ensure they can be easily tapped with a finger. 

• Avoid typing when possible - On a touch interface, typing is not always the optimal 
input method, and even on a standard computer keyboard, minimizing typing can be 
more efficient. Utilize intelligent default field values, value lists, and date pickers. 

• Color - You can enhance the presentation of information through judicious use of color. 
However, be careful because too much color becomes distracting and difficult for the 
user to process. Your user interface should not compete with the data it is presenting. 

• Proximity and Grouping - Items that are close together should be logically related to 
one another. By grouping fields together, you can segment the workflow and help users 
find information easily. 

• Design Patterns - Your app may be unique, but you don’t have to reinvent the wheel. 
Use common design patterns and the Apple Human Interface Guidelines to capitalize 
on models that users are already familiar with. 

• Grids - Use grids as a framework for how information will be presented. Designing on a 
grid helps maintain grouping, spacing and consistency across different screens. 

• Whitespace - Don’t crowd your layout with too many objects. It is better to have 
several screens that are concise in their design and purpose than one large screen that 
crammed full of information that is hard to understand. Let your layouts breathe. 

• Consistency - Use a consistent design model throughout your app. First imagine all 
the different screens you might need to create, and then, as you build them, apply a 
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consistent methodology. Once users become familiar with one area of your app, 
understanding how information is presented and how objects behave, they will 
intuitively understand any other parts of the system that work in the same way. 

Read the Human Interface Guidelines 
The iOS Human Interface Guidelines describe the principles that help you design a superlative user 
interface for iOS apps. These principles are just as important for apps you build with the FileMaker 
Platform as they are for apps built for the App Store. 

Apple's iOS Human Interface Guidelines can be found here: 

https://developer.apple.com/library/ios/documentation/UserExperience/Conceptual/MobileHIG/ 

Read the FileMaker WebDirect Guide 
When creating browser-based apps with FileMaker WebDirect, it is important to follow best 
practices for web design. The FileMaker WebDirect Guide will give you the information you 
need. This includes everything from using web-safe fonts and colors to achieving faster page load 
by including only those objects your users really need. 

The FileMaker WebDirect Guide can be found here: 

https://fmhelp.filemaker.com/docs/15/en/fm15_webdirect_guide.pdf 
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Lesson 13: Review Questions

1. How does having a clear hierarchy help a user interact with an app? 

2. What should be the minimum size of a button on a touch device? 

3. What way of inputting data should be avoided in a touch-enabled app whenever 
possible? 

4. Why is consistency of the interface across an app helpful? 
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Lesson 13: Review Answers

1. Having a clear hierarchy helps users zero in on the content they need. 

2. Buttons should be at least 44pt x 44pt. 

3. Typing with the onscreen keyboard should be avoided when possible. 

4. Consistency of the interface across an app helps users learn more quickly how it 
works. Once they understand one area of the app, they can apply this knowledge when 
encountering other areas. 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Lesson 14: Calculations

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Use the Specify Calculation dialog to define calculation fields. 

• Use functions to manipulate data. 

• Use operators to perform math and compare data. 

Calculations are a key tool in setting up app logic, which helps users complete tasks quickly and 
efficiently, and can be used to control data updates and other processes, resulting in better data 
integrity. You will use calculation functions for many tasks, such as displaying calculation field 
results, field auto-entry and validation, displaying tooltips, filtering portals, displaying conditional 
formatting, and various scripted operations. Because you will use calculation functions so often, 
mastering them is essential. 

Here is what you learned about calculations from the FileMaker Pro Tour. 

Creating Solutions > Calculations


• FileMaker Pro can perform simple and complex calculations on your data. For example, 
you can calculate a discounted price based on a list price and a discount percentage. 

• Your calculations can include text, number, date, time, and container data. 
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Section 1: Creating Calculations

Specify Calculation Dialog 
All calculations in a FileMaker app are defined using the Specify Calculation dialog. The Specify 
Calculation dialog allows you to work with fields, operators, and functions to create a formula. In 
certain cases, you can also control the result type and storage as well. 

Figure 65 shows the Specify Calculation dialog for defining a calculation field. You can choose to 
double-click the fields, operators, and functions to insert them into the formula entry space; or, if 
you prefer, you can type them instead.  

The Specify Calculation dialog makes editing calculations quick and easy. You can search within 
the function and field lists using the Quick Find tool located above each list. As you type in the 
formula entry space, a calculation completion list will appear containing fields, tables, and functions 
that match the text you entered. You can scroll through this list and select an item to add it to your 
formula. 

When defining calculation fields, you must specify the result type at the bottom left of the Specify 
Calculation dialog. The result type dictates how the output will be interpreted by FileMaker Pro. 
Set the result type to that expected of the calculation. For example, the formula Get(CurrentDate) 
+ 14 would be expected to return a date 14 days from today. The formula FirstName & " " & 
LastName would be expected to return text that is the person’s full name. The formula UnitPrice 
* Quantity would be expected to return a number—the total cost for a group of items purchased 
together. 

� 

FIGURE 65
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Creating Calculation Fields 
One requirement for the Equipment Rentals app is to provide two specific pieces of information: 
the number of days a Customer has leased an Asset and the total cost of a Customer’s Assets. 
Calculation fields can produce both of these data points.  

Activity 14.1: Creating a "Days Leased" Number Calculation Field

First you will define a field to calculate the number of days a Customer has leased an Asset. For 
this app, the number of days leased is the difference between the current date and In Service Date. 

1. Navigate to the Fields tab of the Manage Database dialog. Choose the Assets table 
in the Table drop-down, if it is not already selected. 

2. Type Num Days Leased in the Field Name box. 

3. Choose Calculation as the Field Type. 

4. Click Create. 

5. Type the formula Get(CurrentDate) - In Service Date in the formula entry space. 

6. Choose Number for the result type in the lower left corner of the dialog. 

7. Click OK to exit the Specify Calculation dialog and click OK again to exit the 
Manage Database dialog. 

8. Add the Num Days Leased field to the Asset Details - iPad layout, shown in Figure 
66, and check the results of the calculation by modifying the In Service Date field on a 
few records. 
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FIGURE 66
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LESSON 14


Section 2: Functions and 
Operators

Functions 
Functions are used in calculations to perform specific tasks and return a result. Often they accept 
data as one or more parameters, producing a result based on those parameters. For example, the 
Length function takes a single text parameter and returns the length of that text: 

Length ( "Eugene" )


Result: 6 

There are hundreds of calculation functions that have been grouped into various types based on 
their input parameters or result, including text, number, date, time, text formatting, financial, and 
aggregate functions. One special group, the “Get” functions, is noteworthy because many of its 
functions provide information regarding the user’s current session, such as the user’s account 
name, the current layout, the type of device being used, and the current date and time. 

Activity 14.2: Creating a "Total Cost of Assets" Number 
Calculation Field

Next, you will create a calculation field to determine the total cost of a Customer’s Assets, which is 
the sum of the Cost field across all of the Assets attached to a Customer. 

1. Navigate to the Fields tab of the Manage Database dialog. Choose the Customers 
table in the Table drop-down. 

2. Type "Total Cost of Assets" in the Field Name box. 

3. Choose Calculation as the Field Type. 

4. Click Create. 

5. Type the formula Sum(Assets::Cost) in the formula entry space. 

6. The Calculation result in the lower left corner of the dialog should be set to Number. 

7. Click OK to exit the Specify Calculation dialog and click OK again to exit the 
Manage Database dialog. 

8. Add the Total Cost of Assets field to the Customer Details layout as shown in 
Figure 67 and check the results of the calculation. The Total Cost of Assets field 
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should equal the sum of the Cost field from each of the Customer’s related Asset 
records.  

� 

FIGURE 67


Operators 
In addition to the many functions available, you will often use operators to achieve the desired 
calculation result. FileMaker Pro provides the following operators for use in calculations: 

• Standard math operators: add, subtract, multiply, and divide 

• Text operators: carriage return (¶); ampersand (&) for appending one string to another; 
quotes for specifying literal text; and parentheses to manage the order of operations 

• Logical operators: =, <, >, and, or, not, and so on 

When using math operators in calculation formulas, the order of operations follows the rules of 
standard mathematics. Expressions within parentheses are evaluated first, then multiplication and 
division from left to right, then addition and subtraction from left to right. For example: 8 – 3 * ( 1 + 
1 ) returns 2. 

Text operators allow you to combine two or more text items into one larger item. For example, the 
formula FirstName & " " & LastName would return a person’s full name. Note that a space is 
needed within quotes to properly separate the contents of the FirstName and LastName fields. 

Logical operators are used to compare two expressions and return a true or false (1 or 0) result. 
This is known as a Boolean result. For example, (grade > 80 and grade ≤ 89) will return a value of 
1, or true, when the grade field contains a number greater than 80 but less than or equal to 89. 
Logical operators follow mathematical operators in the order of operations. Thus, 2 * 3 >5 
evaluates as 1, while 2 * (3>5) evaluates as 0. They are evaluated in this order: comparisons such 
as the above, then AND,  followed by OR.  

Activity 14.3: Creating a Text Calculation Field

In this activity you will create a Full Address calculation field.  

1. Navigate to the Fields tab of the Manage Database dialog. Choose the Customers 
table in the Table drop-down if it is not already selected. 

2. Type “Full Address” in the Field Name box. 
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3. Choose Calculation as the Field Type. 

4. Click Create. 

5. Type the formula Address & "¶" & City & ", " & State & " " & Zip in the formula entry 
space. 

6. The calculation result in the lower left corner of the dialog should be set to Text. 

7. Click OK to exit the Specify Calculation dialog and click OK again to exit the 
Manage Database dialog. 

8. Add the Full Address field to the Customer Details layout. The calculation result in 
the Full Address field should look similar to Figure 68. 

� 

FIGURE 68


Boolean Results 
Boolean results are an important concept to understand when writing calculations in a FileMaker 
app as they are the building blocks of decision-making. When a calculation returns a true or false 
(1 or 0), this is a Boolean result. In FileMaker apps, the word “True” or any non-zero calculation 
result is considered true. The word “False” or zero is considered false. Boolean results are used in 
features like Conditional Formatting, portal filtering, and Object Visibility, each of which takes action 
when an expression specified by the developer returns a true result. 

From the requirements for the Equipment Rentals file we can infer that the Num Days Leased field 
would not be applicable to an Asset when the In Service Date field is empty. Because of this, it 
would make sense to hide the Num Days Leased field until the In Service Date field contains a 
value. 
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Activity 14.4: Hiding an Object with an Object Visibility 
Calculation

In this activity you will use an Object Visibility calculation to hide the Num Days Leased field and 
its label when the In Service Date field is empty.  

1. Navigate to the Asset Details - iPad layout and enter Layout mode. 

2. Click and drag to select both the Num Days Leased field and its label. Keep both the 
field and its label selected. 

3. In the Inspector, choose the Data tab. In the Behavior section, click on the pencil 
next to the box labeled Hide object when. 

4. Type the formula IsEmpty ( Assets::In Service Date ) in the formula entry space. The 
IsEmpty function returns 1 when its parameter is empty.


5. Click OK to exit the Specify Calculation dialog and enter Browse mode. Try clearing 
the In Service Date field on a few records. The Num Days Leased field and its label 
should not appear when the In Service Date field is empty.


There are many other things you can do with calculations. For example, a calculated status field 
could compare an invoice’s due date with the current date and return either "Open" or “Overdue". 
Other common uses of calculations include formatting phone numbers, calculating sales tax for 
orders, and displaying people’s full names based on their first and last names. 
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Lesson 14: Review Questions

1. What are the three types of objects you can add to a calculation? 

2. What do Get functions return? 

3. What is a function? 

4. What are the different types of operators? 
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Lesson 14: Review Answers

1. The three types of objects you can add to a calculation are fields, operators, and 

functions. 

2. The Get functions return information about the user’s current session. 

3. A function is used in a calculation to perform a task and produce a result. 

4. The three different types of operators are math, text, and logical. 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Lesson 15: Scripting

Lesson Overview 

Time

This lesson takes approximately 40 minutes to complete. 

Objectives

After this lesson, you will be able to: 

• Create, edit, and organize scripts. 

• Attach scripts to buttons. 

• Trigger scripts when opening an app. 

Scripting is another important aspect of app logic. Scripting is a very powerful tool in FileMaker Pro 
that allows you to automate processes in your app by specifying a series of actions that can be 
triggered in a variety of ways. Scripts can serve many purposes, from simple navigation tasks to 
complex reporting and workflow needs. Scripts can be called via buttons on layouts as well as via 
script triggers, which activate a script when a certain action happens, like entering a layout, 
navigating between records, or opening a file. 

Here is what you learned about scripting from the FileMaker Pro Tour. 

Creating Solutions > Scripts


• With FileMaker Pro scripts, you can automate tasks like creating reports or emailing 
customers. 

• A script is a set of instructions, called script steps. 

• Simple scripts can perform a single task. Complex scripts can combine elements (such 
as user feedback) with programming techniques (such as branching and looping). 
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Section 1: What Are Scripts?

A script is a sequence of instructions that accomplish a particular task. For example, Figure 69 
shows a script that can create a new contact record by performing these tasks: 

• Navigating to the Contacts layout 

• Creating a new record 

• Entering default data into the Notes field 

• Placing the cursor in the Title field so the user can begin typing immediately 

� 

FIGURE 69


It may be helpful to think of creating a script as writing a recipe for cooking. A recipe provides 
instructions (measuring, chopping, mixing, stirring, and simmering) in a particular order while 
working with a list of ingredients to produce a desired result. Some recipes (and scripts) are simple, 
while others are more complex and time-intensive. 

Script Steps 
A script is composed of script steps. Script steps are specific instructions that, when strung 
together in a script, can accomplish a larger task. The script steps are pre-defined commands that 
you select from a list. There are more than 150 script steps that perform actions such as navigating 
to a layout, creating and deleting records, and performing finds.  

Most script steps are based on menu items. For example, frequently used menu items such as 
New Record, Enter Find Mode, and Import Records are all script steps. This makes scripting 
easy to learn for users who are familiar with using apps in Browse and Find mode. Almost any 
sequence of actions that a user can do with menu items can be automated and run as a script. 
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Section 2: Creating and 
Organizing Scripts

You can create, edit, and manage scripts using the Script Workspace in FileMaker Pro. If you 
have sufficient access privileges in the file, you can access the Script Workspace window using 
either of these methods: 

• Choose Script Workspace from the Scripts menu. 

• Use the keyboard shortcut Command-Shift-S in OS X or Ctrl-Shift-S in Windows. 

An example of the Script Workspace window is shown in Figure 70. 
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FIGURE 70


All of the scripts that have been created in a given database file are listed in the left panel of the 
Script Workspace window. In a new file that was not created from a Starter Solution, the Script 
Workspace window will be blank.  

Organizing Scripts 
Scripts can be organized into folders for easy grouping and retrieval. A FileMaker app can easily 
contain dozens of scripts, often many more, so keep your scripts organized to save time and effort. 
You can create script folders by clicking the Create new folder icon (# ). You can move scripts 
by clicking the script name and dragging the script to a new location. To find scripts, the Quick 
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Find box at the top of the script list allows you to filter the script list. As you type in characters, only 
those scripts with that character string in their name will appear.  

The checkbox to the left of each script name indicates whether that script is listed in the Scripts 
menu. If you do not see a checkbox next to the script names, use the#  icon in the Scripts 
header to toggle the display of the checkbox. Users can trigger these scripts directly from the 
menu. Typically, you will list only high-level control scripts in the menu, such as Logout, Go to 
Menu, Login again, and Help, but it is up to you to determine what makes sense for your app. 

You can delete scripts by using either of these methods: 

• Control-click (OS X) or right-click (Windows) on the script and select Delete. 

• Press the Backspace or Delete key after selecting one or more scripts. 

Consequences of Deleting Scripts

Be careful when you delete scripts. The delete action cannot be undone and could break existing 
automation in your app. Typically developers use the DDR (Database Design Report) generated by 
FileMaker Pro Advanced to check for any dependencies before deleting a script. 
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Section 3: Editing Scripts

To create a script, click the Create New Script button (# ) in the top left corner of the Script 
Workspace. A new script will appear in a tab on the Script Workspace, shown previously in 
Figure 70. By default, all new scripts are named "New Script". Script names need not be unique, 
but it is a best practice to make names that are unique and that describe the purpose of the script. 

All of the individual script steps are listed on the right side of the Script Workspace. You can add 
a script step to your script using any of the following methods: 

• Double-click the script step in the list on the right. 

• Select the script step in the right panel, then press Enter or Return. 

• Click in the script editing area and start typing the name of the script step to initiate 
script step auto-complete functionality. As you type the name of a script step a list will 
appear containing matching script steps. You can select a script step from this list to 
add it to your script. 

FileMaker Pro does not limit the length of scripts or the number of steps that scripts can perform. 

Not every script step is valid for every FileMaker environment. If you are writing a script intended for 
a FileMaker Go user, for example, limit your script to only those script steps that can be executed 
on iOS devices. The Show Compatibility button ( # ) near the top right of the Script 
Workspace window allows you to select a target platform, such as iOS or FileMaker WebDirect. 
As a result, those script steps that are incompatible with the selected platform will appear greyed 
out. 

When a step in a script is selected, you can view and specify step options by clicking the gear icon 
( #  ) next to a script step. As you learn new script steps, you will learn about the options available 
for specific script steps. (Options for each script step are discussed fully in FileMaker Pro online 
help.) 

If you make a mistake or would like to undo your most recent edits to your scripts, select Undo 
from the Edit menu or use the keyboard shortcut Command-Z in OS X or Ctrl-Z in Windows.  
The undo feature works even after saving changes to a script but does not work if the Script 
Workspace is closed and reopened. 

You can save a script by choosing Save Script from the Scripts menu or by using the keyboard 
shortcut Command-S in OS X or Ctrl-S in Windows. You can always identify a script with 
unsaved changes because you will see an asterisk (*) at the beginning of the script name in the title 
of the script’s tab panel. If you try to close the script’s tab (or run the script) before you have saved 
it, FileMaker Pro will prompt you to save the script. 
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Section 4: Triggering Scripts

After you have created a script, you must decide how and when it will be triggered. Scripts can be 
triggered in many different ways in FileMaker apps, including: 

• Any object on a layout can be defined to be a button and programmed to perform a 
script when a user clicks it. This option is described in detail in the next section, 
"Buttons." 

• Scripts listed in the Scripts menu can be triggered manually by choosing the script 
item from the menu (or by using a keyboard shortcut, when available). 

• Scripts can be defined to call other scripts, causing them to run. This interrupts the 
calling script until the called script is finished running, at which point the calling script 
resumes. The list of scripts that have called other scripts and are waiting to resume is 
named the “script stack”. 

• If you choose File Options from the File menu, you can define a script to trigger when 
any window opens, when the first window opens, when any window closes, and when 
the last window closes. 

• You can define layout or object-level script triggers to run as users interact with your 
app. Some examples of actions that can trigger a script are navigating to a layout, 
clicking or tabbing out of a field, or entering Browse or Find mode. 
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Section 5: Buttons & Button 
Bars

You can use the Button tool to create a button object, or you can cause most of the other layout 
objects to behave just like a button and trigger a script. To access the Button Setup dialog for an 
object shown in Figure 71, use either of these methods: 

• Control-click ((OS X) or right-click (Windows) the object and choose Button Setup 
from the contextual menu. 

• Select the object and choose Button Setup from the Format menu. 

� 

FIGURE 71


�185



FileMaker Training Series: Basics for FileMaker 15

In the Button Setup dialog, typically you choose Perform Script in the Action drop down list and 
then specify which script to trigger. Buttons can also perform single script steps, which can be 
useful for simple navigation (for example, Go To Layout) or creating a record. 

FileMaker Pro provides the ability to display an icon on a button with or without accompanying text. 
The buttons at the top of the Button Setup dialog allow you to choose the position of the icon 
and text on the button. You can choose from a set of predefined icons included with FileMaker Pro, 
and you can also create custom icons. Adding custom button icons is covered in more detail in 
FileMaker Training Series: Advanced, Module 3 (Interface). 

A Button Bar is a series of buttons that have a consistent appearance. Button Bars are useful for 
providing a navigation bar or displaying a series of actions a user may take on a layout such as 
New Record, Duplicate Record, Delete Record, etc. An example of a Button Bar is shown in 
Figure 72. Button Bars are covered in more detail in FileMaker Training Series: Advanced, Module 
3 (Interface). 

� 

FIGURE 72


There are several scripts that need to be created in the Equipment Rentals app to make it more 
useful for Equipment Providers, Inc.’s employees. Among these scripts are:  

• A script to navigate to a list of Customers from the Customer Details layout. 

• A script to make it easier to create new Customers and enter data for a new Customer 
by automatically navigating to the Customer Details layout and placing the user’s 
cursor in the Company field upon creating a new record. 

• A script to view a specific Customer’s Assets in a list view. 

• A script to export the found set of Assets to Excel. 

• A startup script to navigate to the appropriate layout upon opening the file depending 
on the user’s device. 

These are examples of useful features that can make it easier for users to access different areas of 
an app, find specific data, enter new data, and extract data from the system. 

Activity 15.1: Creating a Navigation Script

Create a script that will allow the user to navigate to the Customer List layout from the Customer 
Details layout. You will add a button to the Customer Details layout that performs this script. 

1. Open the Script Workspace by choosing Scripts > Script Workspace... or by using 
the keyboard shortcut Command-Shift-S (OS X) or Ctrl-Shift-S (Windows). 

2. Click the New button ( # ) in the upper left hand corner of the dialog. Change the 
name of the script to "Go to Customer List". 
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3. Double-click the Go to Layout script step in the list of script steps to move it into the 
script editing area. Alternately, you can click in the script editing area and start typing 
“Go to Layout” to trigger the script step auto-completion functionality. 

4. Click on the text “original layout” in the newly added Go to Layout step and choose 
Layout... in the drop down. 

5. Choose the Customer List layout and click OK. 

6. Save the script by choosing Scripts > Save Script or by pressing Command-S (OS 
X) or Ctrl-S (Windows). Close the script’s tab panel by hovering over the blue panel 

containing the script’s name and clicking the ( # ) icon. Close the Script Workspace 
window. 

7. Navigate to the Customer Details layout and enter Layout mode. 

8. Select the Button tool (# icon) from the Status Toolbar. Click and drag on the 
layout to create a button object in the header. The Button Setup dialog will appear. 

9. At the top of the dialog, select the option to display an icon to the left of the button's 

text. In the table of icons, select the #  icon (fourth icon in the first row) and make the 
icon's size 20 pts.  

10. Type Customer List as the button text. 

11. In the Action drop down, choose Perform Script. 

12. Choose the Go to Customer List script and click OK. The Button Setup dialog 
should look like Figure 73. 
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FIGURE 73


13. Enter Browse mode. The Customer Details layout should now look like Figure 74. 

� 
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FIGURE 74
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Test the button to make sure it correctly navigates to the Customer List layout. The current record 
and found set do not change when navigating to the Customer List using this button; it simply 
navigates to the Customer List layout and displays the same set of records. 

Single Step Scripts 
Because this script only contains one script step, the same action could be accomplished by 
having the button execute the Go to Layout script step directly. Most script steps are available to 
be specified as a button’s action when you select Single Step as the button’s action in the Button 
Setup dialog. The limitation with this approach is that only one step can be specified. A script is 
required for a button to perform multiple script steps in a sequence. It is considered a best practice 
to define scripts for all buttons in an app, especially if the action will be repeated in more than one 
location in the app. This is helpful if you later need to add a step to the process like sorting the 
records displayed in the list. Updating a single script is much more efficient than reviewing your 
entire app and updating all the buttons that reference a certain script step. 

The Convert to Script… feature in FileMaker Pro makes the process of switching from a single 
step to a script easier. When specifying the step that a Single Step button will execute, click the 
Convert to Script… button in the lower left corner of the Button Action dialog to automatically 
create a script with the single step included. It is important to note that the Convert to Script… 
button will not re-configure any other buttons in your app to perform the script. You would still 
need to update other buttons in your app to also run the new script if desired. 

Activity 15.2: Script to Create a New Customer

Create a script that will create a new Customer record, navigate to the Customer Details layout, 
and place the user’s cursor in the Company field. You will add a button to the Customer List 
layout that performs this script. 

1. Open the Script Workspace. 

2. Click the New button ( # ) in the upper left hand corner of the dialog. Change the 
name of the script to “Create New Customer". 

3. Add the Go to Layout script step and set it to go to the Customer Details layout. 

4. Add the New Record/Request script step. 

5. Add the Go to Field script step. Click the gear icon ( #  ) on the Go to Field script 
step, click Specify…, and choose the Company field in the Customers table. 

6. Save the script and close the script’s tab and the Script Workspace window. 

7. Place a button in the header of the Customer List layout. Select the option to display 

an icon to the left of the button's text, select the #  icon (last icon in the second row), 
and set the icon size to 20 pts.  
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8. Enter the text “Create New Customer” as the button’s text and set it to run the newly 
created Create New Customer script. The Customer List layout should look similar 
to Figure 75 in Browse mode. 

� 

FIGURE 75


Test the button to make sure it correctly navigates to the Customer Details layout, creates a new 
Customer record, and places your cursor in the Company field. 

Activity 15.3: Script to View a Customer’s Assets

As mentioned previously, a common request from Equipment Providers, Inc.’s customers is to 
receive a list of Assets leased by the Customer. Customers do not have access to the app, so 
Equipment Providers, Inc. will need to export the list of Assets to send to the Customer. The first 
part of this process is to provide an easy way for employees to navigate to a list of a specific 
Customer’s Assets. In this activity you will create a script that will navigate to the Asset List layout 
and display only the current Customer’s Assets, sorted by Category. You will add a button to the 
Customer Details layout that performs this script. 

1. Open the Script Workspace. 

2. Click the New button ( #  ) in the upper left hand corner of the dialog. Change the 
name of the script to “Go to Customer’s Assets". 

3. Add the Go to Related Record script step. Click the gear icon ( #  ) on the Go to 
Related Record script step. 

4. On the Go to Related Record Options dialog, choose Assets in the Get related 
record from: drop down, select the Asset List layout for the Show record using 
layout: option, and check the Show only related records checkbox. Make sure the 
Match current record only radio button is selected. The dialog should look like Figure 
76. Click OK. 
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FIGURE 76


5. Add the Sort Records script step. Click the gear icon ( #  ) on the Sort Records 
script step, and specify to sort by Category from the Assets table in ascending order. 
Click OK to dismiss the Sort Records dialog. 

6. Click the With dialog: option on the Sort Records script step, changing the value 
from “On” to “Off”. When the script is run, the sort dialog will not be displayed to the 
user. 

7. Add the Go to Record/Request/Page script step. Select First as the script step’s 
parameter if it is not already selected. The script should look similar to Figure 77. 
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FIGURE 77


8. Save the script and close the script’s tab and the Script Workspace. 

9. Place a button in the header of the Customer Details layout. Select the option to 

display an icon to the left of the button's text, select the #  icon (first icon in the 
eleventh row), and set the icon size to 20 pts.  

10. Enter the text “Go to Customer’s Assets” as the button’s text and set it to run the 
newly created Go to Customer’s Assets script. 

Test the button to make sure it correctly navigates to the Asset List layout and displays only the 
current Customer’s related Assets sorted by the Category field. 
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Activity 15.4: Script to Export Asset Data

Now you will create the script that exports the current found set of Assets. You will add a button to 
the Asset List layout that performs this script. 

1. Open the Script Workspace. 

2. Click the New button ( #  ) in the upper left hand corner of the dialog. Change the 
name of the script to “Export Assets”. 

3. Add the Export Records script step.  

4. Click the With dialog: option on the Export Records script step, changing the value 
from “On” to “Off”.  

5. Click the gear icon ( #  ) on the Export Records script step. 

6. On the popover that appears, click Specify… next to Specify output file. 

7. On the Specify Output File dialog, click the Add File… button. 

8. On the Export Records to File dialog, select your Desktop as the location for the 
exported file, change the file type to Excel Workbooks (.xlsx), and change the file 
name to “Asset Export”. Click Save. 

9. On the Specify Output file dialog, change the file type to Excel Workbooks (.xlsx) 
and check the box labeled Automatically open file. The dialog should look like Figure 
78. Click OK and click OK again to close the Excel Options dialog. 
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FIGURE 78


10. Click Specify… next to Specify export order on the script step options popover. If 

the popover is not open, click the gear icon ( #  ) on the Export Records script step 
to open the popover. 

11. On the Specify Field Order for Export dialog, click the Clear All button if there are 
fields listed in the Field export order box. 

12. Select Assets in the table drop down menu. Click the Item field once to select it and 
click the Move button to move the field into the Field export order box. Also add the 
following fields to the export order: Model, Serial Number, Category, In Service 
Date, Purchase Date, and Cost. You can Shift-Click, Command-Click (OS X), or 
Control-Click (Windows) to select multiple fields to add to the export order. The 
Specify Field Order for Export dialog should now look like Figure 79. 
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FIGURE 79


13. Click OK to close the Specify Field Order for Export dialog. Save the script and 
close the script’s tab and the Script Workspace window. 

14. Place a button in the header of the Asset List layout. On the Button Setup dialog, 

select the option to display an icon to the left of the button's text, select the #  icon 
(second icon in the second row), and set the icon size to 20 pts. 

15. Enter the text “Export Assets” as the button’s text and set it to run the newly created 
Export Assets script. 

Test the button to make sure it correctly exports the found set of Asset records as an Excel file on 
your desktop named “Asset Export”. 

Create email with file as attachment 
In the Specify Output File dialog there is an option to automatically create an email with the 
exported file as an attachment. When this option is selected, an email is created in your default 
email application (such as Outlook or Mail) that you can then edit and send. This is useful when you 
know that an exported file will need to be emailed immediately without further modifications to the 
file. If you are using FileMaker Pro, this option requires that you have an email application installed 
on your computer. 
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LESSON 15


Section 6: Startup Script

It is often useful to trigger a script to execute when a user opens an app. Common uses for this 
type of script are: 

• Displaying a layout specifically designed for iOS if the user is using an iOS device. 

• Navigating to a different table based on the needs of different user groups. 

You will explore how to use the OnFirstWindowOpen script trigger to accomplish this. 

For the Equipment Rentals file, iOS users are mainly technicians whose responsibilities include 
delivering, installing, and repairing assets for customers and are only interested in working with 
Asset records. The desktop users of the app are the Equipment Providers, Inc.'s account 
managers who are more interested in viewing Customers than Assets because they routinely call or 
send letters to customers. To help these different types of users be more productive, the startup 
script in the Equipment Rentals app should navigate to the appropriate area depending on the 
device being used.  

Activity 15.5: Creating a Startup Script

You will use a combination of the If script step and the Get(Device) function to check the user’s 
device and have the script take different steps accordingly. 

1. Open the Script Workspace. 

2. Create a new script named Startup. 

3. Add the If script step to the script. An End If step is automatically added to the script 
because every If step requires an End If step. 

4. By default your cursor will be placed in the formula entry area for the If step. Enter the 
formula Get(Device) = 3. The Get(Device) function returns 3 if the user is on an iPad. 
Alternatively, you can open the Specify Calculation dialog to enter the formula by 

either clicking the #  icon next to the If step or double-clicking the If step. 

5. Add a Go to Layout script step to the script. Place the step directly after the If script 
step but before the End If script step by clicking and dragging it into position.  

6. Change the Go to Layout script step to navigate to the Asset Details - iPad layout. 

7. Double-click the Else If script step to add it to the script after Go to Layout script 
step. The Else If step allows you to specify another condition to evaluate if the 
condition specified in the If step is false. The Else If step will only be executed when 
the condition specified in the If step is false. 
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8. Click in the formula entry area on the Else If step and enter the formula Get(Device) = 
4. The Get(Device) function returns 4 if the user is on iPhone or iPod touch.  

9. Add a Go to Layout script step between the Else If and End If script step. Change 
the Go to Layout script step to navigate to the Asset Details - iPhone layout. 

10. Add an Else script step directly after the last Go to Layout script step but before the 
End If script step. The Else script step allows you to specify what the script should do 
if the conditions specified in the If and Else If steps are false, meaning the user is not 
using an iOS device. 

11. Add a Go to Layout script step immediately following the Else script step. Specify that 
this Go to Layout script step navigates to the Customer List layout. The script should 
look similar to Figure 80. 
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FIGURE 80


12. Save the script and close both the Startup script’s tab panel and the Script 
Workspace. 

13. Choose File > File Options... and go to the Script Triggers tab. 

14. Check the box next to OnFirstWindowOpen and choose the Startup script. Click OK 
twice to close the Specify Script and File Options... dialogs. 

To test the script, open the Equipment Rentals file from an iOS device. Refer to the deployment 
section for detailed instructions on transferring the file to an iOS device and opening the file with 
FileMaker Go. 

If you do not have access to an iOS device, you can test that the script is executing properly on 
your computer by navigating to the Asset Details - iPad layout, closing the file, then reopening 
the file. The default behavior in FileMaker Pro is to open a file with the last used layout, which was 
the Asset Details - iPad layout in this case, but if the Startup script executes properly, the file will 
open to the Customer List layout instead. 
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Lesson 15: Review Questions

1. Where do a majority of script steps come from? 

2. How do you configure a layout object to activate a script when the user clicks it? 

3. What does the OnFirstWindowOpen script trigger allow developers to do? 
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Lesson 15: Review Answers

1. A majority of script steps come from menu items in Browse, Find, and Preview modes. 

2. Any object on a layout can be turned into a button by using the Button Setup dialog, 
which is accessible from the object’s contextual menu, or by choosing Format > 
Button Setup. Set the button to Perform Script and select the script you want to 
trigger. 

3. Using the OnFirstWindowOpen script trigger, developers can create startup scripts 
that perform tasks such as taking users to layouts built for their specific needs, based 
on the device being used or a given user’s account name. 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Lesson 16: Reporting
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Lesson 16: Reporting

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Describe how a subsummary report works. 

• Explain the concept of a break field. 

• Set up subsummary and grand summary parts. 

• Define and use summary fields. 

• Create basic subsummary reports. 

• Create a chart using Quick Charts. 

One of the most powerful features of FileMaker apps is its ability to aggregate data and summarize 
it in a report. With the right reports, you can gain insight into your business or meet your internal or 
regulatory compliance requirements. To create effective reports, you will need to know how to 
define fields, develop layouts, define calculations, and use scripts. In other words, you will need to 
harness all the skills you learned in previous lessons. 

In this lesson, you will learn how to create a basic subsummary report using summary fields and 
layout parts. You will learn how to use subsummary parts to provide logical groupings of records 
and enhance the usability of a list layout. You will also learn how to make a chart using Quick 
Charts. 

Here is what you learned about charting and reporting from the FileMaker Pro Tour. 

Basics > Charting


• Create charts to compare and contrast data. You can chart individual data values 
(single items sold) or summary data (total sales per quarter) 
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Basics > Reporting


• FileMaker Pro can generate reports to help you organize and analyze your data. 

• You can create custom reports by grouping data. Summary reports can include 
subtotals and grand totals. 

• FileMaker Pro can print your report or email it as an Excel or PDF file. 
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LESSON 16


Section 1: Subsummary Reports

Before you begin building a report, you need to plan what kind of report you want. For the 
Equipment Rentals file, management has asked for a report that shows the total cost of Assets per 
Category so they can evaluate whether investment in assets is properly diversified across the 
different categories. 

You can generate different reports using the same interface by using different found sets. For 
example, a layout that summarizes Assets by Category can potentially present all Assets or only 
those Assets that are currently in service. 

The most powerful type of report in FileMaker Pro is the subsummary report, which presents a list 
of data grouped by the values in a specific field. In the Equipment Rentals app, you have the data 
shown in Figure 81. 

� 

FIGURE 81


One report you can generate from this data is a subsummary by Category as shown in Figure 82. 

�202



FileMaker Training Series: Basics for FileMaker 15

� 

FIGURE 82


As you can see, this kind of report groups all the assets under a subheader for each category. 
Additionally, you can include a row at the bottom of each category that displays the total cost of 
assets in that category using a summary field. 

When creating a subsummary report, the field used to group records is called the break field. In this 
example, Category is the break field. Typically, the break field is a field that contains consistent 
data across multiple records—such as category, type, status, and month—rather than a field with 
continuous or free-form data such as amount, description, or comment. The records are sorted by 
the break field, and whenever a new value is encountered in the sorted field’s data, the report 
"breaks" and starts a new subsummary group. 

Unlike creating layouts that require you to use the Field Picker, FileMaker Pro walks you through 
creating a report like this, including adding fields and adding subtotals and totals. 

Subsummary Parts 
To group records, you need to use a subsummary part. A subsummary part is a layout part that 
displays information for each group of records only when the found set is sorted by the break field. 
The subsummary part and its contents are not displayed at all if the found set is not sorted by the 
break field. 

It is often useful to have two subsummary parts on a layout, one above the body and one below 
the body, with the same break field. This allows you to display a descriptive header for each group 
as well as a total or other aggregated data below the group. Figure 82 illustrates this approach. 
The header is the Category, and the aggregated data is the total cost of assets per Category. 

You can also have many subsummary parts on a layout with different break fields specified. This is 
useful for displaying subgroups within groups. As long as you include the different break fields in 
your sort order, the records will be grouped by each break field. 

Using multiple subsummary parts on a single layout can also be useful for reusing your report 
layout to create reports that are grouped by different fields. Simply by sorting the found set on a 
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different break field, you can cause some subsummary parts to disappear and new ones to be 
displayed, resulting in a report that is grouped differently. It all depends on the break field 
associated with each subsummary part. 

Summary Fields 
Grouping records becomes more valuable when you utilize summary fields to aggregate data for 
each group. A summary field aggregates data across a group of records. Summary fields are 
created via the Manage Database dialog. You can choose options for summary fields through the 
Options for Summary Field dialog as shown in Figure 83. The most common summary 
operations you will use are Total of, Average of, and Count of. 
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FIGURE 83


When a summary field is placed in a header, footer, body, navigation, or grand summary part, it 
aggregates the values from the specified field across all records in the found set. When a summary 
field is placed in a subsummary part, it displays aggregate information about each subgroup of 
records. This means you can use the same summary field to total the cost of assets for each 
category in a subsummary part, and also to total the cost of all assets in the found set in a grand 
summary part. 

Activity 16.1: Creating a Subsummary Report

1. Go to Layout mode and choose Layouts > New Layout/Report.... 

2. Choose Assets in the Show records from drop-down and name the new layout 
"Asset Report". 

3. Click on Computer and then choose Report. Click Continue. 

4. Make sure the options to include subtotals and grand totals are activated and click 
Next. 

5. Double-click on the following fields from the Assets table to specify them for the report: 
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๏ Asset ID 

๏ Item 

๏ Purchase Date 

๏ In Service Date 

๏ Cost 

๏ Category 

6. Click Next. 

7. Double-click on Category in the Organize Records by Category screen. Click Next. 

8. Double-click on In Service Date to also sort by that field in addition to Category. Your 
screen should look like Figure 84, then click Next. 
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FIGURE 84


9. Under Summary field, click Specify.... You have not yet created a summary field. 

10. Click Add. Name the field Cost Total, choose Total of from the options on the left side 
of the dialog, and choose Cost from the field names. 

11. Click OK to create the field and click OK again to choose the newly created field.  

12. Click Add Subtotal and click Next. 

13. On the Specify Grand Totals screen click Specify…, choose Cost Total, and click 
OK. 
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14. Click Add Grand Total and click Next. 

15. On the Header and Footer Information screen, choose Layout Name in the drop-
down for Top left and Current Date in the drop-down for Bottom right. Click Next. 

16. Click Create a script, name it "Asset Report", and check the Run script 
automatically checkbox. This will add an OnLayoutEnter Script Trigger so that when 
a user goes to the Asset Report layout, the script will automatically sort the records. 
Click Finish. 

17. Remove the Category field from the Body and its label from the Header. 

A new layout will be created with the fields, subsummary parts, and the trailing grand summary 
that you specified. The process will do its best to properly size fields, but some adjustment might 
be needed. After resizing and moving fields, and applying the Vibrant theme and data formatting, 
your report should look similar to Figure 85. Note that after exiting Layout mode you may need to 
run the Asset Report script by choosing Scripts > Asset Report in order for the report to be 
grouped correctly. Notice that the Category field has been removed from the body part in Figure 
85. Since the report will always sort, it is unnecessary to show the Category on each row. 
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FIGURE 85


After you perform a find on any layout based on Assets, running the Asset Report script by 
choosing Scripts > Asset Report will generate the report using the current found set. This 
provides a great deal of flexibility in terms of reusing the report with any found set. 

Using Subsummary Parts to Enhance User Experience 
Subsummary parts are also useful for enhancing the usability of list layouts in an app. Grouping 
records based on descriptive data like region, status, or category can make it easier for users to 
locate records. All that is needed to implement this grouping technique is a subsummary part and 
a script to sort records by the break field. 
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Activity 16.2: Adding Groups to a List View

In this activity you will add subsummary parts for the State and Tier fields on the Customer List 
layout and also create the scripts to sort Customer records by those fields. 

1. Navigate to the Customer List layout and enter Layout mode. 

2. Choose Layouts > Part Setup… and click Create… on the Part Setup dialog. 

3. Select the radio button labeled Sub-summary when sorted by and select the State 
field. Click OK and click Print Above. Click Done to close the Part Setup dialog. 

4. Duplicate the State field in the body of the Customer List layout and place it in the left 
side of the subsummary part. Remove the field’s border and make its text larger and 
bold to make it look more like a subheading. 

5. Open the Script Workspace and create a new script named “Sort Customers by 
State”. 

6. Add the Sort Records script step and configure it to sort records by the State field in 
ascending order. Make sure to change the With dialog: option from “On” to “Off”. 

7. Save the script and close both the script’s tab panel and the Script Workspace. 

8. Add a button in the header of the Customer List layout labeled “Group by State”, set 

it to display the #  icon (second icon in the eleventh row) to the left of the text, and 
set it to perform the Sort Customers by State script. 

9. Repeat steps 2-8 for the Tier field. Note that the order of the two subsummary parts 
does not matter for this activity. The Customer List layout should look similar to Figure 
86 in Layout mode. Figure 87 shows how the layout should look in Browse mode 
when records are sorted by the State field. 
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FIGURE 86
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FIGURE 87


Try clicking the “Group by State” and “Group by Tier” buttons. Notice that only one of the 
subsummary parts is displayed at a time. If you were to sort records by both the State field and 
the Tier field at the same time then both subsummary parts would be displayed. 
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LESSON 16


Section 2: Charts

People process images much more quickly than words. As a result, visual displays of information 
are often easier to interpret than written reports presenting the same data. For example, charts can 
help illustrate changes in prices over time, the relative performance of a group of students, and 
much more. 

There are two ways to create charts in FileMaker Pro. The first method, using the Quick Chart 
feature, gives users the ability to chart their data in just a few minutes. The second method offers 
greater flexibility and involves placing a chart object on a layout and manually defining the data 
series to be rendered. You can move, resize, and manipulate a chart object just as you do other 
layout objects, and you can customize the colors, fonts, and backgrounds of a chart. When using 
FileMaker Go and FileMaker WebDirect, charts can be viewed but not created or edited. 

In FileMaker Pro, you can create ten types of charts: column, stacked column, positive/negative 
column, bar, stacked bar, line, area, pie, scatter, and bubble. Over time you will learn which types 
of charts are best for different types of data, so you can communicate your data more effectively. 

Quick Charts 
The easiest way to familiarize yourself with the charting features of FileMaker Pro is to experiment 
with Quick Charts, which can be created from any layout in Browse mode. They are based on 
the current found set and the current sort order, so check both before you generate a Quick 
Chart to make sure they contain the data you want to use. 

Activity 16.2: Creating a Quick Chart

You will create a Quick Chart that shows the number of Assets per Category for the found set. 

1. Go to the Asset Details - iPad layout. 

2. Click Show All in the Status Toolbar if you are not showing all records. 

3. Sort the data by the Category field. 

4. Right-click in the Category field and choose Chart by Category.... The Chart Setup 
dialog will appear, as shown in Figure 88. 
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FIGURE 88


5. Change the Title of the chart to "Assets by Category". 

6. Click on the Styles panel and change the Chart Style to Shaded - 3D. 

7. Click the Save as Layout... button to save the chart as a new layout. 

8. Name the new layout "Assets by Category" and click OK. 

The newly created chart layout will appear in a new window. Note that FileMaker Pro automatically 
creates a script with the same name as the layout and assigns it to the OnLayoutEnter script 
trigger for the new layout. In order to display the chart, first you must sort your found set by 
Category. This script automates that task for you. 
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Lesson 16: Review Questions

1. What is a break field, and how do you use it to define a subsummary part? 

2. How do you add a new subsummary part to a layout? 

3. Name three common summary operations, and explain what results they return for a 
group of records. 

4. When does a subsummary part appear in Browse mode? 

5. What FileMaker product allows you to create Quick Charts? 

6. Which FileMaker products can you use to view charts? 
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Lesson 16: Review Answers

1. Use a break field to divide a found set of records into groups. When you create a 

subsummary part, you specify the break field. If the records are sorted by the break 
field, whenever the value of the break field changes, the report "breaks" by displaying a 
subsummary and starting a new subsummary group. 

2. To add a subsummary part to a layout, go to the Layouts menu, then choose Part 
Setup to use the Part Setup dialog. Create the new part, then define the option to be 
Sub-summary when sorted by. Choose the break field you want from the list of fields 
in the Part Definition dialog. 

3. The most common summary field operations are aggregating the total, count, or 
average of the values from a particular field. Total adds the values for all records in the 
specified field; Count returns the number of records that contain a value in the 
specified field; and Average finds the average for those records that contain a value in 
the specified field—in other words, empty records are not included. For example, if a 
set of five records contains the values of 100, blank, 200, 300, and 200 for a given 
field, the total for that field is 800, the count is 4, and the average is 200. 

4. A subsummary part appears only when you sort records by the field you define as the 
break field for the subsummary part. 

5. Only FileMaker Pro can be used to create Quick Charts. 

6. FileMaker Pro, FileMaker Go, and FileMaker WebDirect can all view charts. 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Lesson 17: Integration

Lesson Overview 

Time

This lesson take approximately 20 minutes to complete. 

Objectives

After this lesson, you will be able to: 

• Export data in common formats. 

• Save layouts to PDF. 

• Describe the differences among FileMaker’s ODBC options. 

The FileMaker Platform uses industry standards to allow it to share information with other 
technologies, whether a FileMaker database is the data source or whether the app looks to outside 
sources. FileMaker’s comprehensive integration features include: 

• Importing from common file formats such as Excel and comma- or tab-separated. 

• Importing from XML or ODBC data sources. 

• Exporting to common formats such as Excel, comma- or tab-separated text, XML, and 
HTML. 

• Saving data to PDF files and appending data to existing PDF files. 

• Making live connections to SQL data sources (Oracle, MySQL, Microsoft SQL Server). 

• Using ODBC/JDBC to access other data sources. 

• Serving as an ODBC and JDBC data sources. 

• Accessing the source code of web pages. 

• Supporting HTML5 via the Web Viewer. 

• Authenticating with Active Directory and Open Directory. 

• Supporting plug-ins to extend functionality. 

FileMaker may also initiate and steer activity in the local operating system with: 
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• Support for AppleScript on OS X and the ability to launch a VBScript file on Windows 
OS. 

• The ability to send email, dial phones, and generate event commands to local 
applications (such as to bring other applications to the foreground). 

• Support for custom URL protocols to open FileMaker files, pass variables to and run 
scripts in those files. 

Here is what you learned about exporting records from the FileMaker Pro Tour. 

Basics > Exporting Records


• You can export data to another FileMaker Pro file or to another file format, such as 
Microsoft Excel. 

• FileMaker Pro exports a copy of your data, leaving the original data in the database. 
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LESSON 17


Section 1: Sharing Data With 
Outside Users

The FileMaker Platform provides many options for sharing data with people who don't have access 
to a FileMaker client application. You can export data to multiple file formats. One typical example 
is exporting mailing address data to share with colleagues. FileMaker Pro also allows you to share 
by creating a PDF of your layouts. This can be used to generate data driven communication like 
letters, invoices, or estimates. You can even save records as Microsoft Excel files with a single 
command. 

Exporting Records 
FileMaker Pro enables you to export data to other file formats, allowing data from a FileMaker app 
to be viewed in other applications. The supported export file formats are: 

• FileMaker Pro (.fmp12) 

• HTML table (.html) 

• Merge (.mer) 

• Microsoft Excel (.xlsx) 

• Tab-Separated Text (.tab or .txt) 

• Comma-Separated Text (.csv or .txt) 

• XML (.xml) 

• dBase format (.dbf) 

There are two commands in the File menu to export data: 

• Export Records - allows you to select which fields to export as well as the format of 
the exported data file. 

• Save/Send Records As - automatically exports the fields on the current layout to 
either a PDF or Excel file. 

Both methods export the current found set, which is useful for exporting a specific data set. For 
example, you might find all active clients or the current month’s orders and then export them to 
share with others. 
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Activity 17.1: Using Export Records

In this example you will export an HTML table of customer addresses for a direct mail service. 

1. Navigate to the Customer Details layout and click Show All Records in the Status 
Toolbar. 

2. In the File menu, choose Export Records.... 

3. Name the file “Customer Export” and choose the Desktop as the save location. 

4. In the Type pop-up menu, choose HTML Table and click Save. 

5. In the Specify Field Order for Export dialog, move the Company, Address, City, 
State, and Zip fields to the Field export order box on the right, as shown in Figure 89, 
by double-clicking each field or selecting the field on the left and clicking the Move 
button. 

� 

FIGURE 89


6. Click the Export button and open the newly created Customer Export.htm file to verify 
the results. 

Saving as a PDF 
FileMaker Pro has built-in functionality for saving data as Adobe® PDF files. A user can create a 
PDF file that matches the current layout’s printed output and that can easily be shared with 
stakeholders. To do this, go to the File menu and select Save/Send Records As > PDF.... 

There are many options available when saving data as a PDF file, including the ability to specify the 
creator, title, and keywords, and to password protect the file. You can also choose to create a new 

�217



FileMaker Training Series: Basics for FileMaker 15

email with the file attached and/or set the file to automatically open after saving. Using a script, you 
can also append new pages to an existing PDF. 
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LESSON 17


Section 2: Integrating with Other 
Data Sources

Integrating a FileMaker app with external systems can enhance its value and extend its capabilities. 
Many situations may require you to get data from or send data to an external system. For example, 
you might have an enterprise-level inventory system, but use FileMaker Pro for the majority of the 
workflow and reporting for your workgroup. Or perhaps you use FileMaker Pro for your web store’s 
content management, but serve the actual website content from an SQL database. 
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LESSON 17


Section 3: What Is ODBC?

You have seen how to incorporate the Web in a FileMaker Pro app, but what if you need to import 
data from another system or want your FileMaker app to serve as the data source for another 
application? To do this, you will need to utilize the ODBC capabilities of the FileMaker Platform. 
Open Database Connectivity (ODBC) is the technology that allows FileMaker Pro to access data 
from external data sources as well as act as the data source for another system. 

FileMaker Pro can connect to the following ODBC data sources, among others: Microsoft SQL 
Server, MySQL, Oracle, and Microsoft Access. Generally, the SQL database language is used by 
most of these. However, ODBC can be used to connect to other data sources as well, so long as a 
compatible ODBC driver is installed on your computer and the proper Data Source Name (DSN) is 
configured. 

There are three different ways to interact with an ODBC data source: External SQL Sources (ESS), 
importing from an ODBC data source, and the Execute SQL script step. The following sections 
will cover the basics of these three methods. 

External SQL Sources (ESS) 
ESS is a feature that allows you to add “shadow” tables from remote SQL sources  to your 
database file, working with them as though they were native FileMaker tables. Your users can 
search for, create, edit, and delete records in the SQL data table directly. You can add table 
occurrences to the Relationship Graph, establish relationships (even between FileMaker tables and 
SQL tables), and view live SQL data alongside FileMaker data. 

When using the ESS feature in files hosted via FileMaker Server, you configure ODBC drivers and 
DSNs only on the server machine, rather than on each individual desktop running FileMaker Pro. 
The seamless integration of the SQL table into FileMaker Pro and the consolidation of the ODBC 
driver and DSN setup to the server machine make ESS the preferred method of integrating with 
SQL data sources. 

ESS is limited to Oracle, MySQL, and Microsoft SQL Server. Consult the FileMaker website for 
more information, including supported versions and appropriate drivers. 

Import from ODBC Data Sources 
Importing records from an ODBC data source is a one-way form of integration between the ODBC 
data source and your FileMaker Pro database. Using this technique, there is no way to edit the 
data that exists in the ODBC source. After importing the data into FileMaker Pro it is possible to 
edit the data, but the changes will not affect the original data source. 

Unlike ESS, this import capability works with any ODBC data source for which you can access an 
appropriate driver, allowing FileMaker Pro to interact with a wide variety of ODBC-based data 
sources.  

�220



FileMaker Training Series: Basics for FileMaker 15

To import records from an ODBC source, you will need to have the appropriate ODBC driver 
installed on each computer from which you intend to use the feature, as well as an appropriate 
DSN configured on each machine. This is unlike the ESS feature that permits the consolidation of 
drivers and DSNs onto the server alone. 

Execute SQL Script Step 
The Execute SQL script step allows a FileMaker Pro app to send SQL statements to a remote 
SQL data source. In some ways, it is the mirror image of the ODBC import functionality. While the 
ODBC import capability can search for and import records, but cannot change data in the ODBC 
data source, the Execute SQL script step can run commands that change data in the ODBC data 
source, but cannot retrieve and display records within FileMaker Pro. The two features used 
together can thus provide full, two-way integration with an ODBC data source. 

This feature, like the ODBC import feature, relies on ODBC drivers and DSNs installed on each 
FileMaker Pro client computer, or on FileMaker Server when the Perform Script on Server script 
step is used to call the Execute SQL script step (refer to FileMaker Training Series: Advanced, 
Module 5 (App Logic: Scripting) for information on the Perform Script on Server script step). It 
will work with a very wide variety of ODBC drivers and data sources. The Execute SQL script step 
requires knowledge of SQL to be used effectively. 
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Lesson 17: Review Questions

1. What are the two ways to export data out of your app? 

2. What file formats can Save/Send Records As… produce? 

3. What are the major benefits to using ESS (External SQL Sources) over the other ODBC 
techniques? 
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Lesson 17: Review Answers

1. Two ways to export data out of your app are Export Records and Save/Send 

Records As…. 

2. Save/Send Records As… can produce Excel (.xlsx) and PDF (.pdf). 

3. ESS allows users to search for, create, edit, and delete records in an SQL data table 
directly without writing any SQL. If FileMaker Server is used to manage the connection, 
it removes the need to install ODBC drivers on multiple devices. It also lets you use the 
Perform Script on Server script step to interact with the SQL source, providing 
FileMaker Go and FileMaker WebDirect clients with indirect access to the SQL data, 
which they otherwise would not have. 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Lesson 18: Security
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Lesson 18: Security

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Objectives

After this lesson, you will be able to: 

• Explain the purposes of accounts, passwords, and privilege sets. 

• Enable and disable the default login account. 

• Create and manage accounts and privilege sets. 

• Explain how external authentication works and why it is useful. 

• Articulate the purpose of the reauthentication extended privilege. 

Security is a primary concern for both developers and end users. It governs whether or not a 
person can open a given file and determines which functions and data are accessible. 

This lesson will introduce you to the FileMaker Platform’s built-in security settings. You will 
incorporate many different aspects of FileMaker security into the Equipment Rentals file. 

Depending on your security compliance and certification requirements, there may be other features 
that you will need to learn beyond what is covered here. 

When securing an app there are three principles to consider: 

• Confidentiality — You have a responsibility to ensure that unauthorized people cannot 
access the data. 

• Integrity — You have a responsibility to allow authorized users to create and update 
data while preventing unintentional changes. You must also restrict access to 
unauthorized users who may tamper with the files. 

• Availability — You have a responsibility to ensure that the data is available to users 
when it is needed. 

The FileMaker security model is based on two key components: 

1. Accounts — identify the individual users. 

2. Privilege Sets — define access limits for the user(s). 
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In this lesson, you will learn about these two key components. 
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LESSON 18


Section 1: Prompt for Login

The first step when dealing with security is to change the login settings that are configured 
automatically when you create a new FileMaker Pro file. By default, a new FileMaker Pro file 
contains an account named Admin, with no password, assigned to the [Full Access] privilege 
set. The file is configured to automatically login with this account. The Full Access privilege set 
allows unrestricted access to the file, including all development functions. As long as this default 
login remains in place, security is effectively bypassed. 

Activity 18.1: Enable Security Settings

The Equipment Rentals file currently has the default security settings. Change the default settings 
to prompt users for a password, and give the Admin account a password. 

1. Choose File > File Options... and uncheck the Log in using checkbox (Figure 90). 

� 

FIGURE 90


2. Click OK. The automatic login behavior is now disabled. The next required step in 
securing the file is to enter a password for the Admin account. 
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3. Choose File > Manage > Security... to open the Manage Security dialog. A security 
alert dialog will appear informing you that the Admin account does not have a 
password. The Manage Security dialog and security alert are shown in Figure 91. If 
this security alert does not appear upon opening the Manage Security dialog because 
you are in the Detailed Setup security dialog, click Use Basic Setup… and click 
Allow on the alert that appears in order to navigate to the Basic Setup dialog. The 
security alert shown in Figure 91 should then appear. The Detailed Setup security 
dialog is covered in detail in FileMaker Training Series: Advanced, Module 7 (Security). 

4. Click the Set Password button. 

� 

FIGURE 91


5. Enter abcde for the password and click Set Password. Click OK again to close the 
Manage Security dialog. 

6. On the Confirm Full Access Login dialog, enter Admin as the full access account 
and abcde as the password and click OK. 

To test these changes, close and reopen the file. You should now be prompted to login when you 
attempt to open the file. Keep full access passwords in a secure place. If they are lost, you may not 
be able to gain full access to the file again. Note that passwords are case sensitive but account 
names are not. 
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LESSON 18


Section 2: Accounts

An account and password combination is the primary means of authenticating a user and is 
required to access any FileMaker app. You can create as many accounts in your FileMaker app as 
necessary, assigning a privilege set to each one in order to establish its specific access privileges. 

Accounts can be authenticated either internally or externally. With internal authentication (via 
FileMaker), the account name and password are stored within the database file itself. One of the 
benefits of using internal authentication is that all of the security setup in an app is handled within 
FileMaker Pro without the need for an external server or FileMaker Server software. This makes it 
the quicker and easier option for managing accounts. 

In the case of external authentication (via Open Directory or Active Directory), FileMaker stores only 
the name of a user group, interacting with an external server to authenticate a user’s account and 
password. External authentication requires that the database is hosted with FileMaker Server and 
that FileMaker Server be configured to allow external authentication (enabled by a single drop-
down in the FileMaker Server Admin Console).  

External authentication still requires a user to provide an account name and password, but instead 
of FileMaker Server verifying those credentials itself, it passes the credentials to the directory 
service. The directory service verifies the user’s credentials and sends back a list of all the groups 
to which the user belongs. This list is then compared to the group names in your FileMaker file, and 
the first valid match determines the privilege set available to the user.  

One of the benefits of external authentication is that you do not need to set up individual user 
credentials in every FileMaker file in your app. Access to the app can be centrally managed using 
the same tools most organizations have in place for granting access to other network services. 
This can save you a lot of time if your app contains many FileMaker files.  

Another benefit is that users do not have to memorize app-specific credentials. The same 
credentials that give them access to their other company systems also give them access to the 
databases that they need to access. 

Whether the account information is stored internally or externally, it is common practice to have an 
account for each user. This is useful because it allows you to track who is creating or modifying 
individual records or taking other actions in your app. You can accomplish this using auto-enter 
field settings or by using the Get(AccountName) function in calculations and scripts. The 
functionality to track this information works the same with both internal and external authentication. 
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LESSON 18


Section 3: Privilege Sets

A privilege set is a specific set of rights given to one or more accounts to access certain parts of 
your system, such as data, layouts, fields, and scripts. By default, a new FileMaker Pro file contains 
three predefined privilege sets: 

• Full Access allows users to have complete access to the file, including all development 
functions (which are required for access to the Manage Database and Manage 
Security dialogs). 

• Data Entry Only allows users to create, edit, and delete records and to import and 
export data. Users cannot access any development functions. 

• Read-Only Access allows users to view and export record data. Users cannot modify 
the file. 

Developers and administrators of a database are usually given accounts associated with the [Full 
Access] privilege set. Full access privileges are required to access the Manage Database and 
Manage Security dialogs, and no other privilege set can be configured to grant these abilities. 

You cannot change or delete these predefined privilege sets, except to assign extended privileges. 
You can, however, create new privilege sets to meet your specific requirements.  

A privilege set can be used by any number of accounts. Typically one account is created for each 
user, and a privilege set for each user group. User groups could be defined as the different 
departments that use an app (Sales, Accounting, Marketing, etc.) or a hierarchy of positions within 
a company (Staff, Managers, Executives, etc.) for example.  

Privilege Sets comprise the following access options: 

• Data Access and Design Privileges provide access to a wide range of security 
control, including records, layouts, value lists, and scripts. 

• Extended Privileges determine the data access methods that are permitted for a 
privilege set. 

• Other Privileges allow printing, exporting, and some other functions. 

One noteworthy feature of the Data Access and Design privileges is the ability to define privileges 
for specific tables, fields, layouts, scripts, and value lists by using the Custom Privileges... option. 
You can even use a calculation formula to determine record access privileges. For example, based 
on a user’s account name, you could allow that user to edit only those records assigned to him or 
her. Using calculations for record level privileges is covered in more detail in FileMaker Training 
Series: Advanced, Module 7 (Security).  

Up until this point, the Equipment Rentals file includes only the default accounts and privilege sets. 
In this task you will create a new account and a new privilege set for technicians. The requirements 
state that technicians will need to be able to edit all Asset data but only view Customer data. They 
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should not be able to delete records in any table. The technicians will not be doing any layout 
design or scripting. They will also need remote access to the file since it will be hosted on a server. 

Activity 18.2: Creating Accounts and Privilege Sets

1. Open the Manage Security dialog by choosing File > Manage > Security…. 

2. Enter the Admin account name and password on the dialog that appears and click OK. 

3. Click New Account. 

4. For the Account Name, type "Bob". 

5. For the Password, click Change… and specify "12345" as the password and click 
Set Password. Check the box for Require password change on next login. 

6. Choose New Privilege Set… from the Privilege Set drop-down. 

7. In the Edit Privilege Set dialog that appears, name the privilege set "Technicians", 
shown in Figure 92. 

� 

FIGURE 92


8. Choose Custom Privileges... in the Records drop-down in the Data Access and 
Design section. This will bring up the Custom Record Privileges dialog. 

9. Click on the Assets table in the list and choose yes in both the View and Edit drop-
downs. Choose no in both the Create and Delete drop-downs and choose all in the 
Field Access drop-down. 

10. Click on the Customers table in the list and choose yes in the View drop-down and 
choose no in the Edit, Create, and Delete drop-downs. Choose all in the Field 
Access drop-down. Click OK. 

11. Specify the following for the remaining Data Access and Design options: 
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๏ Layouts: All view only 

๏ Value Lists: All view only 

๏ Scripts: All executable only 

12. In the Other Privileges area, check the boxes for Allow printing, Allow exporting, 
and Allow user to modify their own password. Choose All in the Available menu 
commands drop-down. 

13. To turn on access to this file when hosted via peer-to-peer or FileMaker Server, in the 
Extended Privileges section, check the box next to Access via FileMaker Network 
(fmapp). The Privilege Set should look the same as Figure 93. 

� 

FIGURE 93


14. Click OK. The Manage Security dialog should now look like Figure 94. 

� 

FIGURE 94
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15. Click OK to close the Manage Security dialog.  

To test the newly created Technicians privilege set, close the Equipment Rentals file, reopen the 
file, and login with the account Bob. You will be prompted to change the password on the 
account. Change the password to anything you would like. Once logged in as Bob, verify that you 
cannot create or delete records and that you cannot modify layouts or scripts. Also verify that you 
cannot edit Customer records but can edit Asset records. 

Note: To allow you to open the file, the completed final file does not have a password for the Admin 
account. 

By implementing accounts and privileges in your FileMaker apps, you are securing your data. For 
Equipment Providers, Inc., the app will limit access properly for Technicians. Other privilege sets 
could be added to provide other classes of users with tailored security measures. While security is 
not a requirement, it is highly recommended for all apps. Now that your FileMaker app fulfills the 
needs of Equipment Providers, Inc., the next lesson will focus on deploying your app. 
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Lesson 18: Review Questions

1. What is the difference between an account and a privilege set, and how are they related 

to one another? 

2. If you open a file using FileMaker Go and are not prompted for a username and 
password, what can you conclude? 

3. How many privilege sets can be associated with one account? 
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Lesson 18: Review Answers

1. The difference between an account and a privilege set is that an account controls your 

ability to open a file, while a privilege set governs what you can see and do in the file. 

2. If you are not prompted for a password, you can conclude that there is a default login 
enabled. 

3. Every account, whether authenticated internally or externally, must be associated with 
one and only one privilege set.  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Lesson 19: Deployment
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Lesson 19: Deployment

Lesson Overview 

Time

This lesson takes approximately 20 minutes to complete. 

Lesson File

Equipment Rentals.fmp12 

Objectives

After this lesson, you will be able to: 

• Describe the differences between peer-to-peer and FileMaker Server hosting. 

• Open files on FileMaker Pro and FileMaker Go. 

• Transfer local files to FileMaker Go. 

The term deployment refers to the various means by which FileMaker developers make apps 
available for use by clients. The term also encompasses the standard practices and procedures by 
which a FileMaker database system is maintained and kept running. 

From FileMaker Server to peer-to-peer sharing to local access, there are many ways to deploy an 
app to multiple users. This lesson reviews the deployment options available for FileMaker apps, 
discussing the specific advantages of each method and when it might serve you best. 

FileMaker apps can be shared in 3 different ways: 

• An app can be opened on your device as a standalone file. The file will normally be 
saved locally on the device accessing the file. 

• An app can be hosted for groups of five or fewer by FileMaker Pro for access by 
FileMaker Pro and FileMaker Go users. 

• An app can be hosted by FileMaker Server for larger groups for access by FileMaker 
Pro, FileMaker Go, and web browser users. In this case, concurrent connections will be 
needed to allow access by FileMaker Go and web browser users. 

In this lesson, you will learn about these methods of deployment. 
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LESSON 19


Section 1: Network Sharing

While a FileMaker app can be used by a single user who opens it locally on their computer or iOS 
device, one of the FileMaker Platform's most valuable features is its ability to allow multiple users to 
access an app simultaneously. There are two ways that a FileMaker app can be shared by multiple 
users. 

Using FileMaker Pro 
FileMaker Pro (or Pro Advanced) can host an app for as many as five users running either 
FileMaker Pro or FileMaker Go. Peer-to-peer sharing is appropriate when a small group of users 
needs occasional access to files. 

There are two steps required to set up peer-to-peer file sharing. First, open the file to be shared in 
FileMaker Pro and enable network file sharing. Then, add the network access extended privilege to 
one or more privilege sets. You can use the FileMaker Network Settings dialog shown in Figure 
95 to complete both steps. To access it, choose File > Sharing > Share with FileMaker 
Clients…. 

� 

FIGURE 95


After Network Sharing is enabled, the IP address of your machine will be displayed. Users, or 
"guests", can use this address to connect to the hosted file. Select the files you want to share from 
the Currently open files list, and then specify which groups should have network access to the 
file. 

Once the above steps are complete — as long as the file remains open on the host machine — a 
user will be able to make a remote connection to the locally hosted file. Details on connecting to a 
hosted file can be found in the next section. 
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Using FileMaker Server 
FileMaker Server is a dedicated product for sharing and maintaining hosted database files. 
FileMaker Server provides many benefits over peer-to-peer sharing, including backup and script 
schedules, SSL encryption, and better shared performance. You use the FileMaker Server 
Admin Console, shown in Figure 96, to configure and manage FileMaker Server via a web 
browser. The console allows you to manage server settings, backup and script schedules, monitor 
server usage, and download database files from a remote connection. 

� 

FIGURE 96


The latest hardware requirements for FileMaker Server can be found at the FileMaker Server 
Technical Specifications page: 

http://www.filemaker.com/products/filemaker-server/server-15-specifications.html 
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LESSON 19


Section 2: Opening FileMaker 
Files

Opening Local Files 
Databases that are stored locally on your computer or iOS device can be opened directly using 
FileMaker Pro or FileMaker Go.  

In FileMaker Pro, choose File menu > Open or press Command-O (OS X) or Ctrl-O (Windows). 
You will then be prompted to locate the file you wish to open. 

In FileMaker Go, after opening the app, the Launch Center appears. The Launch Center 
provides access to recently used files, files on your device, remote hosts, and FileMaker Go 
application settings. 

To open a local file, tap the filename in the list of files on the Device panel. 

Transferring Files to an iOS Device 
There are four methods to transfer files to FileMaker Go so that you can use the files locally on your 
device: 

• Connecting your device to iTunes through your computer with a USB cable. 

• Sending a FileMaker file to your device through email. 

• Accessing a file from a website. 

• Accessing a file from another application, such as Dropbox or Box.com. 

If a file is transferred using any of these methods, the file is copied to the device and will be 
accessible from the Files on Device list within FileMaker Go. 

Activity 19.1: Opening a local FileMaker file with FileMaker Go

You will transfer the Equipment Rentals file to an iOS device and test the functionality in FileMaker 
Go. 

1. Connect your iOS device to your computer via USB and open iTunes. 

2. In iTunes, select your iOS device and click the Apps tab. 

3. Below File Sharing, choose FileMaker Go from the Apps list, then click Add. 
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4. Choose the files to transfer, then click Add. 

5. Open FileMaker Go on your iOS device. Similar to Figure 97, Equipment Rentals will 
appear as a local file. Tap on the file to open it. 

� 

FIGURE 97


Based on the opening script, you will be taken to either the Asset Details - iPhone or Asset 
Details - iPad layout, depending on your device. 

Note: You can also use one of the other file transfer methods mentioned above. 

If a file with the same name already exists, the existing file will not be overwritten. Instead a serial 
number is added to the file name. For example, if the file SomeDatabase.fmp12 already exists on 
your device and then you receive that file again in an email, the emailed copy of the file is renamed 
SomeDatabase 1.fmp12. The next integer is used for each additional copy of the same file. 

FileMaker files copied to an iOS device are accessible by a single user only. This means that data 
entered in a local database will reside only on that device. With additional development, it is 
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possible for a local file to interact with a hosted file and synchronize data between the two. If your 
data must be synchronized with other FileMaker files, you will need to create a data sync process 
by using scripting or a third-party syncing app. 

Opening Hosted Files 
Accessing hosted files in FileMaker Go is similar to the way hosted files are opened in FileMaker 
Pro, including any hosts found on the local network and any hosts saved by manually entering their 
address. Figures 98 and 99 show the FileMaker Go home screen with the Hosts panel selected on 
iPad and iPhone respectively. 

� 

FIGURE 98
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FIGURE 99


To open a file on one of the hosts, tap on Hosts to see a list of files available on that host, then tap 
on a file name to open the file. 
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Lesson 19: Review Questions

1. What are some benefits to FileMaker Server hosting over peer-to-peer sharing? 

2. What are four methods for copying a local file to FileMaker Go? 

3. Can a local file interact with a hosted file? 
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Lesson 19: Review Answers

1. FileMaker Server can share to many more users. It also can protect your data with 

automatic backups and SSL encryption over the network. Using FileMaker Server also 
allows for better performance than peer-to-peer sharing does. 

2. The four methods for copying a local file to FileMaker Go, are: 1) copying a file to the 
device by using iTunes, 2) sending the file using email, 3) downloading the file from a 
website, and/or 4) opening the file in a file-sharing app like Dropbox or Box.com. 

3. Yes, local files can interact with hosted files with a combination of file references and 
scripting. 
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Conclusion
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Conclusion

Congratulations! You have successfully built a FileMaker app that incorporates relationships, 
layouts, calculations, scripts, reports, and security. More importantly, you have a built an app that 
addresses the needs of a business. 

While the Equipment Rentals app you just created contains many features, this only scratches the 
surface of the capabilities of FileMaker Pro. To learn more about all of these features, please 
proceed to FileMaker Training Series: Advanced. 
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Copyright

© 2016 FileMaker, Inc. All rights reserved. FileMaker and FileMaker Go are trademarks of FileMaker, 
Inc. registered in the U.S. and other countries. The file folder logo and FileMaker WebDirect are 
trademarks of FileMaker, Inc. Adobe is either a registered trademark or trademark of Adobe 
Systems Incorporated in the U.S. and/or other countries. Microsoft product screenshot(s) are 
printed with permission of Microsoft Corporation. 

All other trademarks are the property of their respective owners. Product specifications and 
availability are subject to change without notice. 

The example companies, domain names, email addresses, people, places, and events are purely 
fictitious, and any resemblance to existing companies, domain names, email address, people, 
places or events is coincidental. This document may not be reproduced or otherwise redistributed 
without prior consent of FileMaker, Inc. 
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